
Help Guide

SFA - Life Sciences Cloud Platform

This Help Guide describes the SFA - Life Sciences Cloud Platform cloud-based solution for efficiently performing a wide
array of analysis protocols on specific cell populations based on differences in scattered light and fluorescence signal
intensity.

Note

The images used in this Help Guide may differ from the actual display contents of this software.
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What Is SFA - Life Sciences Cloud Platform?

The SFA1)(Spectral Flow Analysis) - Life Sciences Cloud Platform is a cloud-based solution that can efficiently perform a
wide array of analysis protocols, ranging from conventional analysis including gating, in which only specific cell
populations are selected for analysis and quantification based on differences in scattered light and fluorescence signal
intensity, to advanced analysis such as dimensionality reduction, which enables a two-dimensional view of multi-
dimensional information, and clustering, which automatically classifies cell populations.
The solution is compatible with Sony’s flagship ID7000™ Spectral Cell Analyzer. The raw data output and analysis
results from the ID7000 software can be directly imported and analyzed without any conversion. In addition, this solution
features BL-FlowSOM2), a newly developed algorithm that speeds up FlowSOM, one of the clustering methods.
Furthermore, because each algorithm is pre-installed in the cloud environment, immediate analysis is possible, and
results from the data analysis can be managed and shared among users.
A special license needs to be purchased to use Spectral Flow Analysis.

SFA - Life Sciences Cloud Platform is for non-clinical research use only. Not for use in diagnostic or therapeutic
procedures, or for any other clinical purpose.
The user of Spectral Flow Analysis shall not analyze, manage or store any sample data on this product that is, or is
linked with, any personal information of the human sampled, as defined under applicable law.

5-051-744-11(1) Copyright Sony Corporation

SFA is a software name and an abbreviation of Spectral Flow Analysis.1)
BL stands for Batch Learning, a method of batch processing all the data to be trained. FlowSOM is a state-of-the-art clustering and visualization
method that uses Self-organizing Maps (SOM) to analyze flow cytometry data.

2)
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Basic Analysis Functions

Many of the analysis functions including the following that are available in the ID7000 software can also be used in
Spectral Flow Analysis.

Employs fluorescence compensation (unmixing) algorithm – weighted least squares method
(WLSM)
This is a spectral unmixing algorithm based on the least squares method applicable for the detection principle of a
spectral analysis-type cell analyzer. The variances in the signal that is detected generally increases as the fluorescence
intensity increases. In weighted least squares method, this effect is appropriately handled by suppressing the variances
in the calculated results by solving the least squares method with a weighting condition that permits errors due to high
fluorescence intensity.

Unmixing Viewer
The unmixing results can be checked in a list. Manual adjustment is also possible, as required.

Autofluorescence separation
Employs Sony’s unique spectral optical technology for traditionally-difficult autofluorescence spectral separation for
improved data stability and reliability. In Spectral Flow Analysis, you can find the autofluorescence spectrum using a
wizard format just like with the ID7000 software.

Standardization mode
Spectral Flow Analysis also supports the analysis of data acquired in standardization mode in the ID7000 software.
Standardization mode standardizes the output of each channel so that the SSC and fluorescence detection sensitivities
are the same between multiple instruments.

Virtual filter
The virtual filter function provides simple adjustment of channels, and provides the user flexibility for adding
fluorochromes easily as needed. The information for each fluorochrome can be monitored visually in a color palette.

Fluorochromes
Often-used fluorochromes are configured as presets. You can also register user-specific fluorochromes.

Preference settings
You can configure software preference settings for each login user for added convenience.

5-051-744-11(1) Copyright Sony Corporation
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BL-FlowSOM Function

BL-FlowSOM is a clustering function to group data according to the degree of similarity between the data. It speeds up
FlowSOM, which is widely used for flow cytometry analysis (see the following paper for the details), by using a newly
developed algorithm.
With the BL-FlowSOM function, you can select the star, population pie, and median marker value graph modes. In
addition, the expression level of each marker of extracted clusters can be visualized on a heatmap.

For details about the operation, see “Analyzing by Learning Samples” in “Analysis Using the BL-FlowSOM Function.”

S. V. Gassen, B. Callebaut, et al. "FlowSOM: Using self-organizing maps for visualization and interpretation of cytometry
data", Cytometry Part A 87.7, 636-645, 2015.
K. Quintelier, A. Couckuyt, et al. "Analyzing high-dimensional cytometry data using FlowSOM", Nature Protocols 16,
3775-3801, 2021.

Star

This mode visualizes the expression levels of multiple markers.

Population pie

This mode visualizes the proportions of cell populations.
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Median marker value

This mode visualizes the expression level of the marker of one type.

Heatmap
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The expression level of each marker of extracted meta clusters and clusters can be visualized on a heatmap.
Furthermore, you can also change the type of color map (Fluorochrome Color, RdYlBu/8, and YlGn/9). In addition, the
median values (percentage indications) displayed on the heatmap can be output as a CSV-format file.
If you hover the mouse cursor over a color square of the color map, you can check the median value (percentage
indication).

RdYlBu/8

 

Fluorochrome Color

Meta cluster selected in [Gate Manager] or an MST plot1.
Fluorochrome selected in the legend of a star chart2.
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YlGn/9

For details, see “Displaying the Heatmap.”

5-051-744-11(1) Copyright Sony Corporation
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Dimensionality Reduction Function

Dimensionality reduction is a function to “compress” multi-dimensional cell data to display it on a two-dimensional plot by
converting to low-dimensional data while preserving as much of the important information about the multi-dimensional
data structure as possible.
The Spectral Flow Analysis software employs two techniques: “UMAP” and “FIt-SNE.”

For details about the operation, see “Analyzing by Learning Samples” in “Analysis Using the Dimensionality
Reduction Function.”

The following is an example.

Density plots
Density plots display cell populations as densities.

Dot plots
Dot plots allow displaying specific gated cell populations with different coloring by backgating. In addition, intuitive
backgating can be achieved on dot plots by clicking to select the meta-clusters generated by BL-FlowSOM.

14



UMAP

Uniform manifold approximation and projection (UMAP) is a technique whereby the points that are close to an original
feature space are compressed again after they have been compressed so as to make them closer. For details on the
algorithms, see the following paper. With UMAP, you can select a density plot and dot plot.
 
L. McInnes, J. Healy, J. Melville, “UMAP: uniform manifold approximation and projection for dimension reduction,” arXiv
preprint arXiv: 1802.03426, 2018.
E. Becht, L. McInnes, et al. “Dimensionality reduction for visualizing single-cell data using UMAP,” Nat. Biotechnol. 37,
38–40, 2019.

FIt-SNE

FFT-accelerated interpolation-based t-SNE (FIt-SNE) compresses the points that are close to an original feature space
again after they have been compressed so as to make them closer just like with UMAP, but the “closeness” is
represented by probability distribution. FIt-SNE is a technique to speed up t-Stochastic Neighborhood Embedding (t-
SNE) by using FFT and other means. For details on the algorithms, see the following paper.
 
G. C. Linderman, M. Rachh, et al. “Fast interpolation-based t-SNE for improved visualization of single-cell RNA-seq
data,” Nature Methods 16, 243-245, 2019.
L. van der Maaten, G. Hinton, “Visualizing data using t-SNE,” J. Mach. Learn. Res. 9, 2008.

5-051-744-11(1) Copyright Sony Corporation
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Concatenate Function

This topic describes the procedure to use the concatenate function to concatenate multiple samples for learning.
When advanced analysis is performed, learning by concatenating multiple samples is possible. This allows them to be
handled as a pseudo-large sample.
Learning is performed with the data of the samples with check marks in the [Target] column.

For details about the operation, see “Analyzing by Concatenating Multiple Samples (when BL-FlowSOM)” and
“Analyzing by Concatenating Multiple Samples (when UMAP and FIt-SNE).”

5-051-744-11(1) Copyright Sony Corporation
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Data Cleaning Function

In advanced analysis, the quality of the target samples is extremely important, and correct results may not be obtained
with samples containing noise, etc. Therefore, this software also includes a data cleaning function to remove noise and
outliers. Spectral Flow Analysis supports the following data cleaning algorithms.

flowAI
PeacoQC
flowCut
flowClean

For details about the operation, see “Removing Events Containing Noise and Outliers (Data Cleaning Function).”
 
flowAI: G. Monaco, H. Chen, et al. "flowAI: automatic and interactive anomaly discerning tools for flow cytometry data,"
Bioinformatics 32, 16, 2473-2480, 2016.
 
PeacoQC: A. Emmaneel, K.Quintelier, et al. "PeacoQC: Peak‐based selection of high quality cytometry data." Cytometry
Part A 101.4, 325-338, 2022.
 
flowCut: J. Meskas, D Yokosawa, et al. "flowCut: An R package for automated removal of outlier events and flagging of
files based on time versus fluorescence analysis." Cytometry Part A 103.1, 71-81, 2023.
 
flowClean: K. Fletez‐Brant, J. Špidlen, et al. "flow C lean: Automated identification and removal of fluorescence
anomalies in flow cytometry data." Cytometry Part A 89.5, 461-471, 2016.

5-051-744-11(1) Copyright Sony Corporation
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Other Functions

Login mode selection function
The Spectral Flow Analysis software can be used not just on a PC that is used by one person (individual PC) but also on
a PC that is used by multiple persons in a laboratory or other workplace (shared PC).

For details about the configuration, see “Login Modes.”

Workspace and project functions (data sharing)
Each user owns one workspace. Projects can be created in it, and then the data of ID7000 Spectral Cell Analyzer can be
imported to perform analysis and other tasks. Adding other users to your own workspace and projects allows you to
share the data of experiments and spectral references between the project users.

Notification function
You can receive and check notifications from the system, such as a notification that the importing of experiment data has
completed.

For details about the operation, see “Viewing Notifications.”
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Viewing the notification page from Life Sciences Cloud Platform
The service operation status, notifications, and various other information for Life Sciences Cloud Platform can be
checked.

For details about the operation, see “Link Error.”

5-051-744-11(1) Copyright Sony Corporation
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Spectral Flow Analysis Client Operating Environment

The host computer must satisfy the following requirements in order to run the Spectral Flow Analysis software.

Operating system (OS)
A release version of Microsoft Windows 10 or later that is still supported by Microsoft.

CPU
Intel Core i5-8250U CPU or the equivalent or greater

Memory
1920×1080 or greater (Full HD or greater)

Line speed
50 Mbps or faster is recommended for both upstream and downstream

Note
Implement appropriate information security measures (update the antivirus software definition files, run Windows Update,
configure the firewall, manage the ID and password appropriately, and so on) to ensure the computer can be used with peace of
mind. For details, contact your network administrator or IT department.

For details about compatibility-verified antivirus software, contact your Sony distributor.

5-051-744-11(1) Copyright Sony Corporation

20



Help Guide

SFA - Life Sciences Cloud Platform

Overview of Installation Guide

The installation guide describes the license owner operation required to use Spectral Flow Analysis and the operation
performed by that the users who will use Spectral Flow Analysis.

For details about the license owner operation, see “Flow of License Owner Operation.”
For details about the operation performed by the users who will use Spectral Flow Analysis, see “Flow of User
Operation.”

About the License Owner
The user who registered the purchased base license is the owner of that license. The license owner can add users to
use Spectral Flow Analysis.
Only the license owner / license administrator can add options to the base license.

Hint

Once the license owner has added the users to Spectral Flow Analysis, operation by the users becomes possible. The users can
view the license information but cannot add users or add option licenses to the license.

5-051-744-11(1) Copyright Sony Corporation
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License

Spectral Flow Analysis has the following three types of license.

Base (1 type): Standard License
Options (2 types): Additional storage license (one month or one year) and Additonal CPU license

The standard license includes 500 GB of storage space and 500 hours per year of CPU usage time1).
The additional storage license and additional CPU license options are expansion licenses that can be added to the
standard license, as required.

Additional storage license: Adds 500GB of storage space. There are two plans, one yearly and one monthly, because
they need to be synchronized with due date of the standard license.
Additional CPU license: Adds 500 hours of CPU usage time.

The CPU and storage usage amounts of the license are the amounts consumed by the data and analysis in the
workspace of the user associated with that license.

For details about purchasing licenses, contact your Sony distributor.

5-051-744-11(1) Copyright Sony Corporation

The license includes 500 CPU hours when using the [Base] type of analysis server. If you are using the [High] type of analysis server, it will
consume twice the amount of CPU time per hour.

1)
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Flow of License Owner Operation

The flow from purchasing and activating a license to enabling use of Spectral Flow Analysis is as follows.

Hint

The user who registered the license is called the “license owner.”

Determine the license type and purchase the license.

Determine the license type to purchase in consideration of the usage conditions and number of users that will use
the software, then send a purchase order by email to your Sony distributor.

For details about license types, see “License.”

1

Acquire the license ID.

When you purchase a license, a license ID will be issued. The license ID is sent to the users by email together with
the sign-up URL.

2

Create the account of the license owner.

Access the sign-up URL and create the account of the license owner.

For details about the operation, see “Creating an Account.”

3

Install the Spectral Flow Analysis software.

Download and install the Spectral Flow Analysis software.

For details about the operation, see “Installing Spectral Flow Analysis (when License Owner).”

4

Start SFA License Manager.

For details about the operation, see “Starting SFA License Manager (for the First Time).”

5

Activate the license.

Use SFA License Manger to activate the license.

For details about the operation, see “Activating a License.”

6

Add users to the license.

Use SFA License Manager to add the users to use Spectral Flow Analysis to the activated license.

For details about the operation, see “Adding Users to a License.”

7
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Creating an Account

Create an account for using Spectral Flow Analysis.
In the following screens, the items displayed differ depending on the language setting and country/region setting.

Access the sign-up URL.

Access the sign-up URL included in the received email.
The [Create Account] window appears.

1

Enter the email address for signing in to Spectral Flow Analysis in [Sign-In ID], then click [Continue].2

Enter the desired password in [Password] and enter the same password in [Re-enter Password], then click
[Next].

3

25



Select your country or region of residence, enter your date of birth, and click [Next].4

Select a secret question in [Security Question], enter the answer in [Security Answer], and click [Next].

This item can be skipped. It can also be set later.

5
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Enter your first name and last name in [First Name] and [Last Name], then click [Next].6

Place a check mark in [You are confirming that you have read, understand, and accept the Terms of Service
and Privacy Policy] check box, then click [Agree and Create Account].

7
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A confirmation email is delivered to the set email address.

When the confirmation email is received, click [Verify] to complete the confirmation.

Confirmation of the email address is now completed.

8
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When the account is created, the following mail is delivered to the set email address.

Return to the webpage for creating an account, then click [Already Verified] to activate the account.9
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When the account is activated, the “SFA Login Page” page appears.
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If you are the license owner, proceed to “Installing Spectral Flow Analysis (when License Owner).”
If you are the user, proceed to “Installing Spectral Flow Analysis (when User).”

5-051-744-11(1) Copyright Sony Corporation

31



Help Guide

SFA - Life Sciences Cloud Platform

Installing Spectral Flow Analysis (when License Owner)

Download and install the Spectral Flow Analysis software.

Access the following URL, then download the Spectral Flow Analysis software.

For the download URL, contact your Sony distributor.

1

Click [Open] or double-click “SpectralFlowAnalysis-master-Setup.exe” to start the installer.2

When the installation wizard appears, click [Next].3

Click [Install] to start the installation.4

32



Next, proceed to “Starting SFA License Manager (for the First Time).”

5-051-744-11(1) Copyright Sony Corporation

Proceed with the installation by following the on-screen instructions.

When the installation is completed, click [Finish].

When Spectral Flow Analysis is installed, the “Spectral Flow Analysis” shortcut icon is created on the desktop.

5
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Starting SFA License Manager (for the First Time)

This topic describes the procedure for when SFA License Manager is started for the first time by the owner.

Hint

When the Spectral Flow Analysis software is installed, “Life Sciences Cloud Platform” is added to the Start menu of Windows.

Select “Life Sciences Cloud Platform” － “SFA License Manager” from the Start menu of Windows.

A dialog for selecting the login mode appears.

1

Select [Individual PC mode (default)] for an individual PC or [Shared PC mode] for a shared PC, then click
[Next].

For the differences between [Individual PC mode (default)] and [Shared PC mode], see “Login Modes.”

The [Sign In] window appears.

2

Enter the same email address and password as used when creating the account, then sign in to Spectral
Flow Analysis.

3
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After the login succeeded message is displayed, a dialog for selecting the country or region and language appears.

Select your country or region of residence and language, then click [Next].

When the Spectral Flow Analysis software is started for the first time, “End User Agreement” window appears.

4

Read the End User Agreement, place a check mark in [I understand the term of the End User Agreement.],
and click [Accept].

5

35



The “Privacy Settings / Privacy Policy” window appears.

Click the “Life Sciences Cloud Platform Privacy Policy” link and check the privacy policy as required, then
click [Proceed].

Select “(Optional)” as required. The displayed information differs depending on the selected country or region.

6
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Next, proceed to “Activating a License.”

5-051-744-11(1) Copyright Sony Corporation

When the Spectral Flow Analysis software is started for the first time by the license owner, SFA License Manager
starts to enable the licenses to be managed.

37



Help Guide

SFA - Life Sciences Cloud Platform

Activating a License

Use SFA License Manger to register and activate a license.
The user who registered the license is the license owner.

Click [Register License] in SFA License Manager.

The [Register License] dialog appears.

1

Enter the license ID, then click [OK].

The [Register License] dialog appears.

2

Check the license information, then click [OK].

The license is activated and added to [License List].

3

38



5-051-744-11(1) Copyright Sony Corporation

39



Help Guide

SFA - Life Sciences Cloud Platform

Adding Users to a License

Add the users to use Spectral Flow Analysis to an activated license.

Click [Add User] in SFA License Manager.

The [Add User Dialog] dialog appears.

1

Enter the email address of the user, then click [OK].

The user is added to [User List].

2
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To remove a user
Select the user to remove in [User List], then click [Remove User].

5-051-744-11(1) Copyright Sony Corporation

When a user is added to [User List], an invitation email for Spectral Flow Analysis is sent to the user.
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Flow of User Operation

When the license owner adds a user to Spectral Flow Analysis, an invitation email is delivered to the user. When the
invitation mail is received, use of Spectral Flow Analysis can be enabled by performing the operation in the following
flow.

5-051-744-11(1) Copyright Sony Corporation

Create an account.

When a user is added to the license, an invitation email is delivered to the user. Access the link destination included
in the email and then create an account.

For details about the operation, see “Creating an Account.”

1

Download and install the Spectral Flow Analysis software.

When an account is created, the “Welcome to SFA - Life Sciences Cloud Platform” email is delivered to the user.
Access the link destination included in the email, then download and install the Spectral Flow Analysis software.

For details about the operation, see “Installing Spectral Flow Analysis (when User).”

2

Start the Spectral Flow Analysis software.

For details about the operation, see “Starting Spectral Flow Analysis (for the First Time).”

3
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Installing Spectral Flow Analysis (when User)

Download and install the Spectral Flow Analysis software.

Click “software download link” in the “Welcome to SFA - Life Sciences Cloud Platform” email to access the
“Download SFA Software” page.

1

Download the “SpectralFlowAnalysis-master-Setup.exe” file from the “Download SFA Software” page.2

Click [Open] or double-click “SpectralFlowAnalysis-master-Setup.exe” to start the installer.3

43



When the installation wizard appears, click [Next].4

Click [Install] to start the installation.5
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Next, proceed to “Starting Spectral Flow Analysis (for the First Time).”

5-051-744-11(1) Copyright Sony Corporation

Proceed with the installation by following the on-screen instructions.

When the installation is completed, click [Finish].

When Spectral Flow Analysis is installed, the “Spectral Flow Analysis” and “SFA License Manager” shortcut icons
are created on the desktop.

6
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Starting Spectral Flow Analysis (for the First Time)

This topic describes the procedure for when Spectral Flow Analysis is started for the first time.

Double-click the shortcut icon of the Spectral Flow Analysis software.

Alternatively, select “Spectral Flow Analysis” from the Start menu of Windows.

A dialog for selecting the login mode appears.

1

Select [Individual PC mode (default)], then click [Next].

The [Sign In] window appears.

2

Enter the same email address and password as used when creating the account, then sign in to Spectral
Flow Analysis.

3
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A dialog for selecting the country or region appears.

Select your country or region of residence and language, then click [Next].

When the Spectral Flow Analysis software is started for the first time, “End User Agreement” window appears.

4

Read the End User Agreement, place a check mark in [I understand the term of the End User Agreement.],
and click [Accept].

5
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The “Privacy Settings / Privacy Policy” window appears.

Click the “Life Sciences Cloud Platform Privacy Policy” link and check the privacy policy as required, then
click [Proceed].

Select “(Optional)” as required. The displayed information differs depending on the selected country or region.

6
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When the Spectral Flow Analysis software starts, the [Select Workspace] dialog appears.

Select the region of the workspace in [Region], select the workspace in [Workspace List], and click [Next].

[Workspace List] displays workspace that has been automatically created in your own name.
Select workspace that is in your own name here.

7

Select [New Project] in [Project List], then click [OK].8

49
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The Spectral Flow Analysis software window appears.

Hint
The workspace and project can be renamed later. For details about the setting procedure, see “Renaming the Workspace
and Projects.”
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Login Modes

The Spectral Flow Analysis software can be used not just on a PC that is used by one person (individual PC) but also on
a PC that is used by multiple persons in a laboratory or other workplace (shared PC).
Select a login mode when starting Spectral Flow Analysis.

Individual PC mode: This is the mode to use Spectral Flow Analysis on an individual PC that is used by one person.
The login information is saved on the PC for a fixed period of time even after Spectral Flow Analysis is exited, and
the login process is not required at startup during that period.
Shared PC mode: This is the mode to use Spectral Flow Analysis on a shared PC that can be used by multiple
persons. The login information is deleted when Spectral Flow Analysis is exited, and the login process is required at
every startup.

The login process at startup of Spectral Flow Analysis differs depending on the selected login mode. For details about
the operation, see “Using in Individual PC Mode” and “Using in Shared PC Mode.”
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Using in Individual PC Mode

This topic describes the procedure for when the Spectral Flow Analysis software is started for the first time on an
individual PC.

Double-click the shortcut icon of the Spectral Flow Analysis software.

Alternatively, select “Spectral Flow Analysis” from the Start menu of Windows.

After the software version is checked, a dialog for selecting the login mode appears.

Hint
When there is a new software version, an update message appears. Follow the on-screen instructions to update the
software.

1

Select [Individual PC mode (default)], then click [Next].

When the Spectral Flow Analysis software is started for the first time, the [Sign In] window appears.

2

Enter your sign-in ID, then click [Continue].3
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The following screen appears.

Enter your password, then click [Sign In].

If sign-in is successful, the following window appears.

4

Select your country or region of residence and language, then click [Next].5
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The “End User Agreement” window appears.

Read the End User Agreement, place a check mark in [I understand the term of the End User Agreement.],
and click [Accept].

The “Privacy Settings / Privacy Policy” window appears.

6

Click the “Life Sciences Cloud Platform Privacy Policy” link and check the privacy policy as required, then
click [Proceed].

Select “(Optional)” as required. The displayed information differs depending on the selected country or region.

7
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Hint
The computation time and storage usage limit are determined depending on the license. When the limit approaches, a notification
message appears.

After login succeeds when [Individual PC mode] was selected, the login information is saved on the PC for a fixed period of time
even after Spectral Flow Analysis is exited, and Spectral Flow Analysis can be used without performing the login process at
startup during that period.

For details about the subsequent operation, see “Logging In for the First Time.”
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If sign-in is successful, the Spectral Flow Analysis software starts, and the [Select Workspace] dialog appears.
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Using in Shared PC Mode

This topic describes the procedure for when the Spectral Flow Analysis software is started for the first time on a shared
PC that is used by multiple persons.

Double-click the shortcut icon of the Spectral Flow Analysis software.

Alternatively, select “Spectral Flow Analysis” from the Start menu of Windows.

After the software version is checked, a dialog for selecting the login mode appears.

Hint
When there is a new software version, an update message appears. Follow the on-screen instructions to update the
software.

1

Select [Shared PC mode], then click [Next].

The sign-in window appears.

2

Enter the sign-in ID and password, then sign in.

After the license is checked, the following dialog appears.

3

Select your country or region of residence and language, then click [Next].4
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The “End User Agreement” window appears.

Read the End User Agreement, place a check mark in [I understand the term of the End User Agreement.],
and click [Accept].

The “Privacy Settings / Privacy Policy” window appears.

5

Click the “Life Sciences Cloud Platform Privacy Policy” link and check the privacy policy as required, then
click [Proceed].

Select “(Optional)” as required. The displayed information differs depending on the selected country or region.

6
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Hint
The computation time and storage usage limit are determined depending on the license. When the limit approaches, a notification
message appears.

If [Shared PC mode] was selected, the login information is deleted when Spectral Flow Analysis is exited, and the login process is
always required at the next startup.

For details about the subsequent operation, see “Logging In for the First Time.”

5-051-744-11(1) Copyright Sony Corporation

When the Spectral Flow Analysis software starts, the [Select Workspace] dialog appears.
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Workflow

This topic describes the basic procedures to view the data of ID7000 Spectral Cell Analyzer in the Spectral Flow Analysis
software, and perform advance analysis.
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Export the data from the ID7000 Spectral Cell Analyzer.

For details about the operating procedure, see “Exporting Data in the ID7000 Software.”

1

Log in to Spectral Flow Analysis.

For details about the operating procedure, see “Logging In for the First Time” and “Logging In from the Second
and Subsequent Time.”

2

Import the exported data into the Spectral Flow Analysis software.

For details about the operating procedure, see “Importing Data.”

3

Select the data to be analyzed and view the results of analysis in the ID7000 Spectral Cell Analyzer.

For details about the operating procedure, see “Searching Experiments” and “Viewing Analysis Results.”

4

Open the [Analysis] tab.

For details about the operating procedure, see “Opening the [Analysis] Tab.”

5

Add and edit plots or create gates, then analyze the data.

For details about the operating procedure, see “Adding Plots,” “Adding Gates,” and “Editing Items Displayed in
the Statistics Table.”

6

Execute dimensionality reduction or BL-FlowSOM, and perform advanced analysis.

For details about the operating procedure, see “Analyzing by Learning Samples” in “Analysis Using the
Dimensionality Reduction Function” or “Analyzing by Learning Samples” in “Analysis Using the BL-FlowSOM
Function.”

7
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Logging In for the First Time

Select the workspace and project, then log in.

Double-click the shortcut icon of the Spectral Flow Analysis software.

Alternatively, select “Spectral Flow Analysis” from the Start menu of Windows.

After the software version is checked, a dialog for selecting the login mode appears.

1

Select the login mode, then click [Next].

The subsequent procedure varies depending on the selected login mode.

See “Using in Individual PC Mode” when using on an individual PC, and “Using in Shared PC Mode” when
using on a shared PC.

When you log in for the first time, the [Sign In] window appears.

2

Enter your sign-in ID, then click [Continue].

The following screen appears.

3
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Enter your password, then click [Sign In].

If sign-in is successful, the [Select Workspace] dialog appears.

Hint

The computation time and storage usage limit are determined depending on the license. When the limit approaches, a
notification message appears.

4

Select the region of the workspace in [Region], select the workspace in [Workspace List], and click [Next].

[Workspace List] displays workspace that has been automatically created in your own name.
Select workspace that is in your own name here.

5
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Select [New Project] in [Project List], then click [OK].

The Spectral Flow Analysis software window appears.

6
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Hint
The workspace and project can be renamed later. For details about the setting procedure, see “Renaming the Workspace
and Projects.”
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Logging In from the Second and Subsequent Time

Double-click the shortcut icon of the Spectral Flow Analysis software.

Alternatively, select “Spectral Flow Analysis” from the Start menu of Windows.

A software version check is performed. When the limit for remaining storage space approaches, a message
appears to notify you about it.

Hint
When there is a new software version, an update message appears. Follow the on-screen instructions to update the
software.

If a dialog to select the login mode appears, follow the on-screen instructions to set the login mode.

The computation time and storage usage limit are determined depending on the license. When the limit approaches, a
notification message appears.

The [Select Workspace] dialog appears.

1

Select the region of the workspace in [Region], select the workspace in [Workspace List], and click [Next].2
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Select a project, then click [OK].

The Spectral Flow Analysis software window appears.

3
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Exiting Spectral Flow Analysis
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Open the [File] tab, then click [Exit].

You can also exit the software by clicking [X] at the top right of the window.

A confirmation message appears.

1

Click [Yes].

The data is saved. In addition, if the analysis server is running, the server is terminated after saving data
completed.

Hint

To forcibly terminate the analysis server while performing lengthy process such as advanced analysis, click [Force
Terminate] button which is shown on the data saving dialog. Please note that the analysis results may be incomplete when
the server is forcibly terminated.

The software exits.

2
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Viewing Notifications

Click  at the top right of the window to view the notifications from the system.
When there are new notifications, the number of new notifications is notified in red like .

A blue circle mark is displayed for an unread notification.
Click [Details] to view detailed information.
To mark all notifications as read, click [Mark all as read].
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Updating the Software

When the Spectral Flow Analysis software is started, the following window appears if a new version is available.

Clicking [Update Now] will automatically download the new installer and update the software.
Follow the on-screen instructions to update the software. Start Spectral Flow Analysis again after the update completes.
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Exporting Data in the ID7000 Software

Export the experiment data you want to analyze in the Spectral Flow Analysis software from the ID7000 software in
exdat format.
Images in this section are from the ID7000 Software, not Spectral Flow Analysis Software.

Hint
The menus and buttons displayed vary depending on the user account privileges.

Display the [Database] window of the [File] tab in the ID7000 software, then click [Export].

The [Export Experiment Data] dialog appears.

1

Select the experiment you want to export, specify the export destination, and click [Export].

Select the experiment you want to export in [Experiment List], then click [Move] to add it to the [Export Experiment
List].
Clicking [Move All] adds all the experiments to the [Export Experiment List].

2

70



5-051-744-11(1) Copyright Sony Corporation

Select the experiment you want to export in [Experiment List], then click [Move] to add it to the [Export
Experiment List].

1.

Click [Browse] to select the export destination folder.2.
Click [Export].
The experiment data is exported in exdat format.

3.

When the exporting completed message appears, click [OK].3

Click [Close] to close the dialog.4
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Importing Data

You can import the data exported from the ID7000 Spectral Cell Analyzer and upload it to cloud storage, then view the
analysis results in the Spectral Flow Analysis software. Please note that data containing the personal information of
subjects cannot be handled in Spectral Flow Analysis.

Display the [Experiment] window of the [File] tab in the Spectral Flow Analysis software, then click [Import].

The [Import Experiment Data] dialog appears.

1

Specify the experiment to import, check that it does not contain any personal information of subjects, place
a check mark in the [I confirmed that the import files do not contain any personal information of subjects.]
checkbox, and click [Import].

The experiment data is imported and uploaded to cloud storage.

2

When the upload start message appears, click [OK].

The experiment metadata is registered in the database, and uploading to cloud storage for measurement sample
data starts.

3

Click [Close] to close the dialog.

The experiment metadata is registered, uploading of the measurement sample data to cloud storage and
processing start, then the experiment data is added to [Experiment Explorer] on the [View] tab.

4
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When uploading to cloud storage for measurement sample data completes, the analysis process is executed
automatically in the cloud, and the analysis results can be viewed on the [View] tab.
A busy icon is displayed for an experiment in the process of being imported.
You can confirm the progress of the import process for each sample from the following icons.

: Uploading (initial)/enabled
: Upload completed and processing (prepared and processing)/enabled
: Processing completed (done)/enabled

73



Help Guide

SFA - Life Sciences Cloud Platform

Searching Experiments

Search for experiments by date and keyword.

Open the [View] tab, specify dates and keywords in [Experiment Explorer], and click [Search].

Clicking  displays a calendar to specify a date.

The experiments are searched using the specified criteria, and a list of experiments appears.

1

Open the desired experiment, then select a sample to analyze.

The data is displayed on the worksheet.

2
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Selecting a Sample for Analysis

An experiment consists of plates, sample groups, and samples as shown below.

Open the experiment you want to analyze in the experiment list on the [View] tab, then select a plate.1

Select a sample to analyze on the [Plate] panel.

The analysis data is displayed on the worksheet.
If you select a plate then select a well/tube, the data is displayed on the worksheet for the corresponding well/tube.

2
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Viewing Analysis Results

View the analysis results for the data of the ID7000 Spectral Cell Analyzer on the [View] tab.

Note

You can only view analysis results on the [View] tab. To further analyze data, you need to switch to the [Analysis] tab. For the
operating procedure, see “Opening the [Analysis] Tab.”

To display data for analysis

Search for the target data in the [Experiment Explorer] pane on the left side of the [View] tab, then select the well you
want to analyze.

Main functions of the [View] tab

[Experiment Explorer] pane
Selects data to analyze. You can also search experiments by date and keyword.

1.

Plots
Displays the data of analysis results.
A plot that lists the spectra of each laser is called a “ribbon plot.”

2.

Statistics table3.
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Displays statistics calculated automatically from acquired data.
Gates
Configures settings to group events with common characteristics, isolating them from all other events.

4.

[Experiment] panel
Displays the structure of the experiment.

5.

[Plate] panel
Displays a list of wells. You can switch the display to list view or map view.
The icon of a well/tube varies depending on the worksheet mode.

: [Shared] mode
: [Individual] mode

6.
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Opening the [Analysis] Tab

To further analyze the data imported from the ID7000 Spectral Cell Analyzer, you need to switch to the [Analysis] tab.

Right-click the experiment to analyze in the experiment list on the [View] tab, then select [Start Analysis].

You can also perform the same operation by selecting the experiment to analyze and clicking [Start Analysis] at the
bottom of the window.

The next dialog appears.

1

Select an analysis server type, then click [Yes].

The specs of the server to be used differ depending on the analysis server type. If [High] is selected, a server with
high specs is used, but a lot more computer time will be consumed. Normally, selecting [Base] is recommended.

2
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Compared to when using the [Base] type of analysis server, the [High] type of analysis server consumes twice as
much CPU time per hour as the [Base] type.
When the analysis service becomes available, the tab switches to the [Analysis] tab and the following message
appears.

Click [OK].

After a while, the experiment becomes active and analysis will be possible.

3
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Adding Plots

You can add plots to the worksheet.

Click the type of plot to add in the [New Plot] group on the [Worksheet Tools] tab of the ribbon.

A plot is added to the worksheet. The new plot created represents the [All Events] population.

1

Change the layout of plots, as required.

You can change the position of plots by dragging the title part of target plot and dropping it to a new location.

You can also zoom in/out to change the display size of plots individually by dragging the bottom right of the plot.

2
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Changing Axis Scales

Select a plot on the worksheet, then click the desired axis scale using the buttons in the [Scale] group on the [Plot Tools]
tab of the ribbon.
You can also drag the axis on the plot to change the axis scale.

For details about the function of each button, see “[Plot Tools] Tab (Ribbon).”
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Changing Axis Parameters

Click the axis title and select the desired parameter from the context menu.
Parameters are grouped by [Scatter (Area)], [Fluorochrome (Area)], [Others], [Scatter], [Fluorochrome], and [Detection
Channel], and are displayed for each excitation laser.

Example: Changing the X axis to FSC area data
Click the X-axis title and select [FSC_A] from the popup menu.
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Changing the Source Gate of a Plot

Click the gate name on the top left of a plot and select the root gate from the drop-down list.
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Changing Several Plots Simultaneously

You can select multiple plots on the worksheet and apply the same settings to all plots at the same time. The settings
that can be applied to more than one plot at the same time include changes to gates and axis parameters (for example,
FSC to FITC), changes to axis scales (for example, Max 1 × 104 to 1 × 105), and changes to axis scale type (for
example, log to linear).
This topic describes changes to the root gate as an example.

You can apply the same operation to multiple selected plots at the same time using the [Plot Type], [Scale], and [Copy
Picture] group buttons on the [Plot Tools] tab of the ribbon.

Select the target plots, and then select the root gate.

You can select multiple plots by clicking plots while holding down the Ctrl key.

The root gate is changed on the selected plots at the same time.

1
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Changing the Plot Type
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Select a plot whose type you want to change on the worksheet.1

Click the target plot type in the [Plot Type] group on the [Plot Tools] tab of the ribbon.

The same operation is available by right-clicking a plot and selecting [Plot type].
The diagram below shows changing to a histogram plot as an example.

The type of the selected plot is changed.

2
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Duplicating Plots
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Select a plot to be duplicated on the worksheet, then click [Duplicate Plot] in the [Edit] group on the [Plot
Tools] tab of the ribbon.

The same operation is available by right-clicking a plot and selecting [Duplicate].

The selected plot is duplicated.

1

Edit the duplicated plot, as required, using the buttons on the [Plot Tools] tab of the ribbon.

For details about each button, see “[Plot Tools] Tab (Ribbon).”

2
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Removing Plots

Select a plot to be removed on the worksheet, then click [Remove Plot] in the [Edit] group on the [Plot Tools] tab of the
ribbon.
The same operation is available by right-clicking a plot and selecting [Remove].
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Adding Gates

You can separate events into groups by drawing gates around the events on plots. Gates of different types (Rectangle,
Ellipse, Polygon, Quadrant, Linear) are available which can be drawn to match the distribution of events. Adding a gate
allows you to display a new plot representing the population of events that fall within the gate.

Select a plot on which to add a gate.

Zoom in or out on the plot, as required, using controls in the [View] group on the [Worksheet Tools] tab of the ribbon
to make it easier to draw the gate on the plot.

1

Click the button for desired gate type to surround the target population in the [New Gate] group on the [Plot
Tools] tab of the ribbon, and draw a gate on the plot.

Alternatively, right-click the plot, then select the gate type from [Insert Gate] in the context menu.

[Rectangle]: Adds a rectangle gate.
[Ellipse]: Adds an ellipse gate.
[Polygon]: Adds a polygon gate.
[Quadrant]: Adds a quadrant gate. Quadrant gates are added with the intersection point of the quadrants at the
position of the mouse click. Gates “<gate_name>-Q1” to “<gate_name>-Q4” are added to the four quadrants on the
plot. Drag the intersection point to change the size of the quadrants.
[Linear]: Adds a linear gate. Linear gates can be added to histogram plots only.
The gate is added to the plot and the population percentage statistic for the gate is displayed.
Example: Polygon gate

2
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Example: Linear gate

Edit the name of the gate, the displayed statistic, color, and other preferences, as required.

Select the gate, click [Gate Manager] or  in the [Edit] group on the [Gate Tools] tab of the ribbon, and configure
the settings in the displayed dialog.

[Gate Manager]: Displays the [Gate Manager] dialog. For details about the setting items, see “[Gate Manager]
Dialog.”

 : Displays the [Gate Properties] dialog. You can perform the same operation from the right-click context menu.
For details about the setting items, see “[Gate Properties] Dialog.”

3
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Editing Gates

You can change the shape of and settings for gates on plots.

To change the shape of a gate
Select the gate and drag the drawing handles to change the shape.
For quadrant gates, drag the intersection point of the quadrants to another position to change the gate.

To move a gate
Select the gate and drag the gate to the desired position.

To rotate a gate
You can rotate polygon and ellipse gates.

Select a polygon gate or ellipse gate.1

Move the rotation handle to rotate the gate in any direction.2
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To change gate color and statistics information
Select a gate, then select the desired color in the [Color] group on the [Gate Tools] tab of the ribbon.
You can change the font size and the statistic that is displayed for a gate on a plot in the [Label] group.

To change gate settings
Select the gate, click [Gate Manager] or  in the [Edit] group on the [Gate Tools] tab of the ribbon to display the [Gate
Manager] dialog or [Gate Properties] dialog, respectively, and then change the settings.

For details about the settings items, see “[Gate Manager] Dialog” and “[Gate Properties] Dialog.”

To delete a gate
Select the gate to be deleted, then click [Remove Gate] in the [Edit] group on the [Gate Tools] tab of the ribbon.
Alternatively, right-click the gate and select [Remove] from the context menu.

Note
Deleting a gate will delete all data and statistics for the gate, including all child gates and plots derived from the gate.

To move a gate
Right-click the gate you want to move in the statistics table, and select [Cut] from the context menu.
Right-click the move destination gate, and select [Paste] from the context menu.

To duplicate a gate
Right-click the gate you want to duplicate in the statistics table, and select [Copy] from the context menu.
Right-click the duplicate destination gate, and select [Paste] from the context menu.

Note

Gates cannot be moved to another worksheet. When duplicating gates on other worksheets, some gates may not be duplicated
due to the difference of fluorochromes in the color panel.
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Editing Items Displayed in the Statistics Table

Click [Edit] in the [Statistics] group on the [Worksheet Tools] tab of the ribbon.

Alternatively, right-click the statistics table and select [Open Statistics Editor] from the context menu.

The [Statistics Editor] dialog appears.

1

Edit the items displayed in the statistics table.2
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To copy item settings displayed in the statistics table to another gate
Select the copy source gate, then right-click and select [Copy] from the context menu. Then, select the copy destination
gate, then right-click and select [Paste] from the context menu.

To change the width of columns in the statistics table

Hint
To delete a pulse parameter, select the pulse parameter row and click [Delete].

Select a gate.
The display parameters and statistics values for the selected gate are displayed in the lower area.

1.

Click [Add] to add statistics for fluorochrome parameters and pulse parameters.
A new parameter configuration item is added to the bottom with each click. Select [Parameter] and [Type] to
select the parameters to display.

2.

Place a check mark in the checkboxes for the statistics you want to display for each fluorochrome and type
parameter.

3.

Click [Close] to close the dialog.4.
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Drag the right edge of a table column to change the width of the column.
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Exporting Statistics Table Information as a CSV File

You can export the statistics table as a CSV file.

Click [Export Statistics] – [Sample] in the [Statistics] group on the [Worksheet Tools] tab of the ribbon.

The [Export to CSV File] dialog appears.

1

Specify the path of the CSV file export destination, then click [Export].

Information for the statistics table displayed on the worksheet is saved in a CSV file.

2

When the exporting completed message appears, click [OK].3

Click [Close] to close the dialog.

Sample CSV file export

4
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Displaying Multiple Spectral Data Overlaid

You can overlay spectral data of multiple plots on a single plot to compare analysis results.

Click [Overlay Worksheet] in the [Overlay] group on the [Worksheet] tab of the ribbon and select the
worksheet display method for overlays.

[Half Worksheet View]: Displays the overlay worksheet in the bottom half of the worksheet.
[Full Worksheet View]: Displays the overlay worksheet occupying the full area of the worksheet.
The overlay worksheet is displayed on the worksheet.
 
Display example: When [Half Worksheet View] is selected

1

Right-click a spectrum or ribbon plot with the spectral data to be overlaid, and select [Send to Overlay]
from the context menu.

The spectral data is displayed in the plot of the overlay worksheet.

2
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To delete spectral data
You can delete the spectral data using one of the following methods.

Right-click a row in the legend of the overlay plot and select [Remove].
Right-click within the overlay plot, and select [Remove All] from the context menu.

To change the spectral data type
Right-click within the overlay plot, and select [Change Data Type] - [Mean] (average), [SD] (standard deviation), or [CV]
(coefficient of variance) from the context menu.

To export the overlay plot data as a CSV file
Right-click within the overlay plot, and select [Export Data to CSV File] from the context menu.

To copy the overlay plot and legend to the clipboard
Right-click within the overlay plot, select [Copy to Clipboard] – [Overlay Plot] or [Overlay Plot with Legend] from the
context menu, and paste into another application.
You can paste the image into an external application, such as Microsoft PowerPoint or Microsoft Word.
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You can show/hide the spectral data by turning the checkbox in the legend on/off.
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Ending Analysis (Terminate the Server)

To terminate the server when ending analysis, perform the following procedure.
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Open the [File] tab, then click [Exit].

You can also exit the software by clicking [X] at the top right of the window.

A confirmation message appears.

1

Click [Yes].

After the data has been saved, the analysis server will be terminated.

2
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Undo/Redo Function

Undo/redo buttons are located in the title bar of the main window. Worksheet actions, including those listed below,
support the undo/redo function.

Creating plots or gates
Deleting plots or gates
Editing plots or gates
Resizing/moving worksheet items
Editing the [Gate and Statistics] table
Adjusting the Spectral Reference

Actions, such as those listed below, do not support the undo/redo function.

[Sync scale and gate]
[Change palette]
Changes to the [Spectrum Display]
[Edit color]
Changes to the worksheet mode
Copying and pasting worksheets
[Unmixing] – [Apply] on/off
When a dialog, such as the [Plot Properties] dialog, [Gate Properties] dialog, [Gate Manager] dialog, or [Statistics
Editor] dialog, is displayed
Changes to the zoom factor of the worksheet
Changes to displayed events
Adding plots from the [Unmixing Viewer] or [Autofluorescence Finder]
[Data Cleaning]
[BL-FlowSOM]
[UMAP]
[FIt-SNE]
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Creating a Spectral Reference

A spectral reference provides information about the shape of the fluorescence spectrum, which is used for fluorescence
unmixing. A spectral reference can be created from the acquisition data of a single stain control.

Import a single stain control using the target fluorochrome.

Note
A positive control (PC) and a negative control (NC) acquired under the same acquisition conditions are required.

The positive and negative controls differ only in the presence/absence of staining. Basically, the same type of particles
must be used. For example, if a single stain beads control is prepared as the positive control, import a control using the
same type of beads, unstained, for the negative control.

1

Open the desired experiment, then select a sample to analyze.

Set Positive and Negative controls for each fluorochrome.
Set gates corresponding to the positive control and negative control populations, for the prepared single stain
controls and unstained control, and assign them to the fluorochromes in the [Unmixing Settings] dialog.
Example:

2

Add a gate to the density plot for the FITC single stain control.
Display the FITC single stain control, click [Ellipse] in the [New Gate] group on the [Plot Tools] tab of the ribbon,
and add the gate to the FSC-SSC density plot.
You can adjust the axis scale or zoom the plot, as required, if the gate is difficult to draw.

1.

Add a histogram plot and add a gate to the FITC positive population.
Right-click the gate added in step 1, and select [Create a Child Plot] – [Histogram Plot] to add a histogram, and
change the horizontal axis to FITC-A.
Select the histogram plot, click [Linear] in the [New Gate] group on the [Plot Tools] tab of the ribbon, and add a
linear gate to the FITC negative population.

2.
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You can display a spectrum chart by right-clicking the gate for the FITC positive population and selecting
[Create a Child Plot] – [Spectrum Plot] to check that the gate is set appropriately.

Click [Unmixing Settings] in the [Unmixing] group on the [Unmixing] tab of the ribbon.

The [Unmixing Settings] dialog appears.

3.

Assign the configured gate to the FITC positive control.
Click [Positive] for FITC in the fluorochrome list, and select the gate set for the FITC positive population from
the displayed list.

4.
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Set the gate for the unstained control corresponding to the FITC positive population above.
Repeat steps 1 to 3 for the unstained control.
First, set a gate for the data for the unstained control.

Next, add a histogram plot.

Display a spectrum plot to check that the gate is set appropriately.

5.
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The populations specified for Positive and Negative must basically be the same type of cells. Accordingly, on
the FSC-SSC plot, the gate should be set in roughly the same position as the gate for the FITC positive
population. If not set correctly, the correct spectral reference will not be obtained due to the effects of
autofluorescence of cells.

Assign the configured gate to the FITC Negative control.6.

Assign the gates for Positive and Negative controls for all fluorochromes in the same way.

When assigning an unstained sample that is common to multiple fluorochromes, you can assign a gate to
Universal Negative and then set the Negative of each fluorochrome to Universal Negative to eliminate the need
for individual Negative gate settings.

7.

Click [Calculate].3
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If a data saturated warning appears
When calculating a spectral reference, the percentage of event data that was saturated at the time of acquisition in the
gates set to the positive gate and negative gate is evaluated, and a warning is displayed if it is determined that the
quality will be affected. If you want to exclude saturated event data from the spectral reference calculation, place a check
mark in [Calculate Spectral Reference without saturated event(s)], and click [Continue].

If a caution mark appears in the [Unmixing] panel
The quality of each spectral reference is evaluated when it is calculated. If a spectral reference conflicts with the
following conditions, the quality is deemed to be bad, and the caution mark appears for the corresponding fluorochrome
in the [Unmixing] panel.

The reason can be displayed by hovering the mouse over the caution mark.

Spectral index error
The caution mark appears if the spectral index value derived from the Area/Height parameters of the data used to
calculate the spectral reference is less than 5.

The fluorescence unmixing is calculated.
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Negative value error
The caution mark appears if the negative value in the calculated spectral reference is higher than 10% of the
maximum positive value.

If a conflict occurs, the following types of waveforms are displayed.

To remove a fluorochrome from the list
Right-click the target cell, and select [Remove Fluorochrome].
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When the confirmation message appears, click [Yes].
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Registering a Spectral Reference in the Library

You can register a calculated spectral reference in the spectral reference library.

Right-click [Fluorochrome settings] in the bottom right of the [Unmixing Settings] dialog, then select [Add
to Library] from the context menu.

The [Add to Library] dialog appears.

1

Place a check mark for the spectral reference to register in the library, enter the required metadata, and
click [Add to Library].

2
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The spectral reference is added to the library.
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Applying Fluorescence Unmixing

Click [Apply] on the [Unmixing] tab of the ribbon to perform fluorescence unmixing.

Before unmixing

After unmixing

Analyzing Indexed Data
Use the various tools to analyze the data.
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Adjusting Spectral Unmixing Manually (Spectrum)

You can adjust fluorescence unmixing graphically on the worksheet using a mouse if you want to adjust the fluorescence
unmixing values obtained using the spectral reference.

Hint
Changing the spectral unmixing on a plot will also change the unmixing on other plots having the same fluorochrome as one of its
parameters, changing the position of events. Accordingly, you should add plots for the required spectral parameters to the
worksheet before adjusting spectral unmixing manually in order to monitor the effect of adjusting the unmixing on each plot.

Display the worksheet for the well whose spectral unmixing you want to adjust.1

Create a density plot or dot plot, and specify fluorochromes for both the X axis and Y axis.2

Click [Spectral Reference Adjuster] in the [Spectral Reference] group on the [Unmixing] tab of the ribbon.3
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The [Spectral Reference Adjuster] dialog appears. The waveforms of the spectral reference for each fluorochrome
are displayed in the dialog.

A diagonal line appears on plots that have fluorescence parameters on the X and Y axes.

Place the mouse cursor over a plot, and drag the plot to change the unmixing for the target parameter.

The mouse cursor changes to a horizontal double-ended arrow cursor in the left half of the plot, and a vertical
cursor in the right half of the plot.
Dragging the mouse on the plot that you want to adjust will modify the spectral reference, changing the calculated
results. The target spectrum to modify is displayed highlighted in the spectrum display area of the dialog.

4

117



Hint

The adjustment result can be saved as a new spectral unmixing matrix or can overwrite an existing spectral unmixing matrix. You
can reload the pre-adjustment fluorescence unmixing matrix using [Load Spectral Reference] on the [Unmixing] tab of the ribbon.
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When unmixing finishes, click [OK] in the [Spectral Reference Adjuster] dialog.

The [Save unmixing matrix] dialog appears.

5

Select a matrix to overwrite in [Matrix List] or enter a matrix name in [Name] to save a new matrix, and click
[Save].

6
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Checking Fluorochrome Unmixing Results Summary

You can check the results of fluorescence unmixing by displaying a list of plots for each fluorochrome combination.
You can also make manual adjustments to spectral unmixing as required.

Display the worksheet for the well/tube whose spectral unmixing result you want to check.1

Turn [Unmixing] on at the top right of the worksheet.2

Click [Unmixing Viewer] in the [Spectral Reference] group on the [Unmixing] tab of the ribbon.

The Unmixing Viewer launches.

3
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Select a fluorochrome for the X axis in [X Axis].

You can also select the previous or next fluorochrome using [Prev] and [Next], respectively.

4

Adjust the spectral unmixing as required.5

Turn [Adjuster] on at the top of the window.
The mode becomes spectral reference adjustment mode, and a diagonal line is displayed on plots.

1.
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Place the mouse cursor over a plot, and drag the plot to change the unmixing for the target parameter.
The mouse cursor changes to a horizontal double-ended arrow cursor in the left half of the plot, and a vertical
cursor in the right half of the plot.
Dragging the mouse on the plot that you want to adjust will modify the spectral reference, changing the
calculated results. The target spectrum to modify is displayed highlighted in the spectrum display area.

2.

When adjustment is finished, click  of [Adjuster] at the top of the window.

A message appears to confirm whether to save the adjusted unmixing matrix.

6

Click [Save] to save the matrix, or [Discard] to not save it.7
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Hint
Changing the spectral unmixing on a plot will also change the unmixing on other plots having the same fluorochrome as one of its
parameters, changing the position of events. The Unmixing Viewer displays plots of all fluorochrome combinations, so check the
plot display for the corrected fluorochrome axis.
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When you click [Save], the [Save unmixing matrix] dialog appears. Follow the on-screen instructions to enter the
matrix name and save the matrix.

Turn [Adjuster] off at the top of the window to exit spectral reference adjustment mode.

If you clicked [Discard] in step 7, [Adjuster] is turned off.

8

If there is a plot you want to add to the worksheet, select the plot and click [Add to Worksheet] at the
bottom right of the window.

A confirmation dialog appears.
Clicking [OK] closes the Unmixing Viewer and then adds the plot to the worksheet.

9

Click [Close] to exit the Unmixing Viewer.10
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Finding Autofluorescence Populations

You can find the autofluorescence spectrum in acquisition data by searching for the autofluorescence populations.

Hint

The [Autofluorescence] tab of the [Unmixing Settings] dialog and the worksheet are updated after using the Autofluorescence
Finder.

Display the worksheet for the well/tube whose autofluorescence populations you want to find.1

Click [Autofluorescence Finder] in the [Autofluorescence] group on the [Unmixing] tab of the ribbon.

A message appears to confirm whether the unstained control for which you want to find autofluorescence is
selected.

2

Check that the well/tube of the unstained control is selected, then click [OK].

The [Autofluorescence Finder] dialog appears.

3

In [Step 1], add the appropriate gates to the FSC/SSC plot.4
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The added gate automatically is reflected as the parent gate in [Step 2].

Hint
Gate the corresponding populations to make later adjustment easier.

You can adjust the axis settings on a plot (maximum value, minimum value, Biexponential axis parameter) by dragging the
axis on the plot.

To select all events without adding a new gate, place a check mark in [Use all Events].

In [Step 2], search for the autofluorescence population while changing the virtual filter ranges.

You can change the wavelength band of the virtual filters to any range using the mouse.
If you want to change the Y-axis of the plot to the wavelength range selected by the virtual filter, select the virtual
filter of the desired laser axis from [Y Axis].

5
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Hint

You can adjust the axis settings on a plot (maximum value, minimum value, Biexponential axis parameter) by dragging the
axis on the plot. The axis type is fixed to the type set before displaying the [Autofluorescence Finder] dialog.

Add a gate for the population to register as the autofluorescence population.

Hint
Up to eight autofluorescence components can be registered as fluorochromes named “AF color 1” up to “AF color 8.”

6

Click [OK].

Note

7
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The gate created in the [Autofluorescence Finder] dialog and its corresponding plot are added to the worksheet. Gates
previously created in the Autofluorescence Finder are also updated.

A confirmation message appears.

Click [OK].

A reconfirmation message appears.

8

Click [Apply].

The worksheet is updated.

9
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Check the calculated spectral reference in the [Unmixing Settings] dialog.10
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Removing Events Containing Noise and Outliers (Data Cleaning Function)

This topic describes the procedure to remove events containing noise and outliers using the data cleaning function.
Running the data cleaning function generates a new gate. The generated gate includes only events determined to be of
good quality by the algorithm.

Click [Data Cleaning] in [Data Quality] on the [Gate] tab of the ribbon.

The [Data Cleaning] dialog appears.

1

Set each item.2

Select the fluorochromes to use as inputs.

128



5-051-744-11(1) Copyright Sony Corporation

For details about each setting item, see “[Data Cleaning] Dialog.”

When data cleaning ends, a new gate is generated.

1. Configure the data cleaning parameters.2.
Click [OK].3.
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Analyzing by Learning Samples

BL-FlowSOM is a clustering function to extract a cell population automatically by applying the technology of machine
learning.
Set the learning conditions, and analyze by learning samples. With BL-FlowSOM, you can select the star, population pie,
and median marker value graph modes.

Click [BL-FlowSOM] in [Clustering] on the [Gate] tab of the ribbon.

The [BL-FlowSOM] dialog appears.

1

Set each item.2
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For details about each item, see “[BL-FlowSOM] Dialog.”

An empty plot appears, and a busy icon is displayed at the top right during learning. When leaning finishes, an MST
plot is displayed.

Select the samples to concatenate when analyzing by concatenating samples.
For details about the operation, see “Analyzing by Concatenating Multiple Samples (when BL-FlowSOM).”

1.

Select the fluorochromes to use as inputs.2.
Configure the learning parameters.3.
Click [OK].4.
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Select the graph mode.

Right-click within the plot, and select the graph mode from [Graph Mode] in the context menu.
You can also select the graph mode in the  menu at the top right of the MST plot.

[Star]: Visualizes the expression levels of multiple markers.

3
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[Population Pie]: Visualizes the proportions of cell populations.

[Median Marker Value]: Visualizes the expression level of the marker of one type.
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Analyze using the various tools.

For details about the various tools, see “Tool Menu Overview.”

4
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Visualizing the Proportions of Cell Populations

Population pie allows you to visualize the proportions of the cell populations selected in the [Gate Manager] dialog.

Select [Gate Manager] in [Gates] on the [Worksheet Tools] tab of the ribbon.

The [Gate Manager] dialog appears.

1

In the [Paint] column, place check marks in the checkboxes for the cell populations you want to visualize.

Change the color of the cell populations in [Color], as required.

Color is applied only to the selected cell populations.

2
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In addition, if you hover the mouse cursor over the population pie, you can check the proportion of the cluster star
for each gate.
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Tool Menu Overview

There are the following tools for MST plots.

Toolbar
The toolbar has the following tool menus.

 menu: Selects the graph mode.
 menu: Edits meta clusters.
 menu: Configures settings and performs operations related to meta clusters.

[Meta]/[Clus]/[None] menu: Switches between meta cluster selection mode and cluster mode.
 : Allows moving the display area by dragging when an MST plot is displayed zoomed in.
 menu: Displays plots zoomed in.

[…] menu: Performs tasks such as backgating and copying to the clipboard.

For details about each tool, see “Toolbar.”

1.

Context menu
Combines some of the menus on the toolbar into one.

For details about menu items, see “MST Plots.”

2.
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Toolbar

The toolbar for MST plots has the following menus.

 menu
Selects the cluster mode.

[Star]
Visualizes the expression levels of multiple markers.
[Population Pie]
Visualizes the proportions of cell populations.
[Median Marker Value]
Visualizes the expression level of the marker of one type.

1.

 menu
Configures settings and performs operations related to meta clusters.

[Show Meta]
Displays the meta clusters.
[Constant Size]
Displays the circles of meta clusters at a constant size. The circle size can be changed in the properties of the MST
plot.
[Show Heatmap]
Displays a heatmap of the selected meta cluster or cluster. You can change the color map, and output the median
values displayed on the heatmap as a CSV-format file.

For details about the operation, see “Displaying the Heatmap.”

2.
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[Show Star Chart Legend]
Selects the markers to display when star chart.

[Show Meta Cluster Star Chart]
Displays a start chart on a meta cluster basis when star chart.

[Constant]: Place a check mark here to display the circles of meta clusters at a constant size.
[Use Min]: Place a check mark here to set the minimum size for displaying the circles of meta clusters.

 menu
Edits meta clusters.

3.
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[Merge to existing Meta Cluster]
Merges the selected meta cluster with another meta cluster.
[Create new Meta Cluster]
Creates a new meta cluster.
[Revert to original Meta Cluster]
Returns the meta cluster to the state immediately after running BL-FlowSOM.
[Cluster]/[Meta Cluster]
Switches between meta cluster selection mode and cluster selection mode. Make sure you switch the mode before
operating meta clusters or clusters.
[Cluster]
Cluster selection mode
[Meta Cluster]
Meta cluster selection mode

4.

 menu
Allows moving the display area by dragging when an MST plot is displayed zoomed in.

5.

 menu
Displays the plot zoomed in to 200% or 500%. If you select [Reset], the plot returns to its original size.

6.

[…] menu

[Back Gating]
If [Back Gating] is turned on and the mode is switched to [Back Gating], the [Paint] fields in the [Gate Manager]
dialog turn on for a metacluster selected on the MST plot, and the events in that metacluster are displayed in color on
the dot plot.

7.

141



5-051-744-11(1) Copyright Sony Corporation

[Copy to Clipboard]
Copies the selected plot to the clipboard so that it can be pasted in other software for use in a report or other content.
[Properties]
Displays the properties for the selected plot. You can change each item, as required.

[Node Rate]: Changes the display size of cluster circles.
[Meta Rate]: Changes the display size of the fill color of meta clusters.
[Constant Size]: Changes the size of the circles of meta clusters for when [Constant Size] is selected in the menu.
[Edge Width]: Changes the width of an edge.
[Edge Color]: Changes the color of an edge.
[Margin]: Changes the margin between a plot frame and graph.
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Displaying the Heatmap

You can change the type of color map, and output the median values (percentage indication) displayed on the heatmap
as a CSV-format file.

To display the heatmap

To change the type of color map
Select the type of color map in [Color Map].
You can select the following color maps.

Fluorochrome Color
RdYlBu / 8
YlGn / 9

Select [Show Heatmap] from the  menu on the toolbar.

The heatmap is displayed.

1
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To check the expression percentage
If you hover the mouse cursor over a color square, you can check the expression percentage.

To display the heatmap of clusters
When the icon on the left of the metacluster name is clicked to expand the metacluster, the clusters are displayed.

Fluorochrome selected in the legend of a star chart1.
Meta cluster selected in [Gate Manager] or an MST plot2.
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To output the heatmap as a CSV-format file
The median values displayed on the heatmap can be output as a CSV-format file.
Click [Export to CSV File], and specify the destination folder in the displayed dialog.
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Analyzing by Learning Samples

Dimensionality reduction is a function to “compress” multi-dimensional cell data to display it on a two-dimensional plot by
applying the technology of machine learning. You can use either the “UMAP” or “FIt-SNE” dimensionality reduction
technique.
Set the learning conditions, and analyze by learning samples. With dimensionality reduction, you can select a density
plot or dot plot.

Select the gates to be analyzed, and click [UMAP] or [FIt-SNE] in [Dimensionality Reduction] on the [Gate]
tab of the ribbon.

The [UMAP] dialog or [FIt-SNE] dialog appears.

1

Set each item, then click [OK].

When [UMAP] is selected

2
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When [FIt-SNE] is selected
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For details about each setting item, see “[UMAP] Dialog” and “[FIt-SNE] Dialog.”

An empty plot is displayed during learning. When leaning finishes, a density plot for the learning results is
displayed.

Select the samples to concatenate when analyzing by concatenating samples.
For details about the operation, see “Analyzing by Concatenating Multiple Samples (when UMAP and FIt-
SNE).”

1.

Select the fluorochromes to use as inputs.2.
Configure the learning parameters.3.
Click [OK].4.

148



Select the plot type, as required.

Right-click within a plot, select [Plot Type] in the context menu, and select the plot type.
Select any of [Density Plot], [Dot Plot], [Histogram Plot], [Contour Plot], and [Color Axis] for the plot type.

A color axis displays the specified fluorochrome emphasized. It is suitable for viewing the expression intensity.
Using a color axis in combination with dimensional compression can be useful.

3
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With a dot plot, you can color specific cell populations. For details about the operation, see “Coloring Cell
Populations (Dot Plot).”
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Coloring Cell Populations (Dot Plot)

With a dot plot, you can color specific cell populations (gates and meta clusters).

Select [Gate Manager] in [Gates] on the [Worksheet Tools] tab of the ribbon.

You can also perform the same operation by right-clicking within the dot plot and selecting [Open Gate Manager]
from the context menu.

The [Gate Manager] dialog appears.

1

Color the cell populations.2
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In the [Paint] column, place check marks in the checkboxes for the populations you want to color.
You can operate all manual gates and meta cluster gates simultaneously by using [Check all manual gates],
[Uncheck all manual gates], [Check all meta cluster gates], and [Uncheck all meta cluster gates].

1.

Select the population whose color you want to change.
You can use [Move to top], [Move up], [Move down], and [Move to bottom], as required, to change the order
used when coloring.

2.

Change the color of the cell population in [Color].3.
Click [Close] to close the dialog.4.
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Analyzing by Concatenating Multiple Samples (when BL-FlowSOM)

When BL-FlowSOM is performed, learning by concatenating multiple samples is possible. This allows them to be
handled as a pseudo-large sample.
When using BL-FlowSOM, select the concatenation result after the samples have been concatenated, then run analysis
again.

Transfer the samples to be concatenated to the [Analysis] tab with [Start Analysis] in advance.1

Display the dialog for configuring the learning conditions, then click [Concatenate Other Samples].

The [Sample Selection] dialog appears.

2

Place check marks in the checkboxes for the samples to concatenate, then click [OK].

The dialog displays all of the samples on the [Analysis] tab.

Selected samples that can be concatenated are displayed.
The following samples are excluded.

Sample where a gate selected as a target for running advanced analysis does not exist
Sample where there is no fluorochrome selected in the [Fluorochrome] list

3

Check the message, then click [OK].4
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The number of samples to be concatenated is displayed.

Click [OK] and run BL-FlowSOM.

The result of BL-FlowSOM are displayed on the MST plot when learning using concatenated samples finishes.

5
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Analyzing by Concatenating Multiple Samples (when UMAP and FIt-SNE)

When UMAP and FIt-SNE are performed, learning by concatenating multiple samples is possible. This allows them to be
handled as a pseudo-large sample. After advanced analysis has completed, the analysis results related to only the
sample selected among the concatenated sample data are displayed on the worksheet. The operating procedure is the
same for both UMAP and FIt-SNE.

Transfer the samples to be concatenated to the [Analysis] tab with [Start Analysis] in advance.1

Display the dialog for configuring the learning conditions, then click [Concatenate Other Samples].

The [Sample Selection] dialog appears.

2

Place check marks in the checkboxes for the samples to concatenate, then click [OK].

The dialog displays all of the samples on the [Analysis] tab.

Selected samples that can be concatenated are displayed.
The following samples are excluded.

Sample where a gate selected as a target for running advanced analysis does not exist
Sample where there is no fluorochrome selected in the [Fluorochrome] list

3

Check the message, then click [OK].4
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The number of samples to be concatenated is displayed.

Set the fluorochromes to use as inputs and the parameters for learning, then click [OK].

The selected samples are concatenated and analyzed.

5
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Adding Users to a Workspace

Each user owns one workspace, and other users can be invited to that workspace, and groups can be set. For
experiment data to be viewed and analyzed by multiple users, those users need to be invited and added to the
workspace.

Display the [File] tab, then click [Information] – [Workspace and Project Information].

The [Workspace and Project Information] dialog appears.

1

Check the workspace to which to add users in [Region / Workspace], then click [Show Workspace Users].

The [Show Workspace Users] dialog appears.

2

Click [Invite].3
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The [Invite User] dialog appears.

Enter the email address of the user you want to invite, place check marks in the checkboxes of the projects
you want the user to join, and click [Invite].

The [Invite User] dialog closes and the user is added to the list of users in the [Show Workspace Users] dialog.

4

Click [Close] to close the dialog.

An invitation email is sent to the email address entered in step 4.

5

Click “approval link” contained in the invitation email.

The browser starts and the workspace invitation acceptance complete page is displayed.

6
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Creating a Project

You can create a project in a workspace that you own. The users who have been invited to the workspace can be added
to the project.

Hint
An experiment will be imported into the project.

Display the [File] tab, then click [Information] – [Workspace and Project Information].

The [Workspace and Project Information] dialog appears.

1

Set each item.2
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Check the workspace in which to create the project in [Region / Workspace].1.
Select [Add] in [Project List].
“New Project” is added to the list.

2.

Enter a name for the project in [Name], then click [Save].3.

To add a user to the project, click [Show Project Users].

The [Show Project Users] dialog appears.

3

Click [Add Users].

The [Add Project User] dialog appears.

1.

Select the user you want to add, then click [Add].2.
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Hint
You can change the role of a user, as required. For details, see “[Change Project Role] Dialog.”

The added user is displayed in the list of users in the [Show Project Users] dialog.

To add a user to the project, you need to add the user to the workspace in advance. For details about the
setting procedure, see “Adding Users to a Workspace.”

Click [Close] to close the dialog.3.

Click [OK] in the [Workspace and Project Information] dialog.4
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Renaming the Workspace and Projects

You rename only the workspace and projects that you own.

Display the [File] tab, then click [Information] – [Workspace and Project Information].

The [Workspace and Project Information] dialog appears.

1

Change the name, then click [OK].2
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To rename the workspace, edit the name in the [Workspace] field, and click [Save].1.
To rename a project, select the project in [Project List], edit the name in the [Name] field, and click [Save].2.
Click [OK].3.
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Configuring User Preference Settings

Various default function settings can be saved by each user in user preferences. User preferences are loaded
automatically, eliminating the need for some configuration settings when you want to perform acquisition, analysis, or
sorting.

Display the [File] tab, then click [Information] – [Preference Settings].

The [Preference Settings] dialog appears.

1

Set each item.

The values set here become the default values used for each function.

2
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To import/export user preference settings
You can import the preference settings of another user and export your own preference settings.
Click [Preference Settings] in the bottom right of the [Preference Settings] dialog, and select [Import] or [Export] from the
displayed menu.
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For details, see “[Preference Settings] Dialog (Overview).”
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Worksheet Modes

In the Spectral Flow Analysis software, worksheets are used in the following structure just as in the ID7000 software.
A worksheet assigned to a sample group is called a “Shared Worksheet,” and a worksheet assigned to a sample is called
an “Individual Worksheet.” A shared worksheet allows each sample within the sample group to use the same worksheet.
Please note that the worksheet mode set when importing cannot be changed in Spectral Flow Analysis.

A shared worksheet supports two sharing modes: [Individual] mode and [Shared] mode.

[Shared] mode
Refer to the shared worksheet when analyzing each sample. This mode is intended for cases where analysis is
performed using the same plot, same gate, and same statistics with all samples within a sample group.

[Individual] mode
Refer to the individual worksheet when analyzing each sample.
This mode is intended for cases where analysis is performed using a unique gate or plot with each sample within a
sample group.
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Setting the Worksheet for the Specified Sample as theShared Worksheet

Right-click a well or sample tube, and select [Copy to Shared Worksheet] from the context menu.
The worksheet for the specified sample is copied as the shared worksheet for the sample group.

Hint
The shared worksheet is displayed by selecting the sample group within [Experiment List].
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Copying a Shared Worksheet to the Worksheet of All Samples

 
Right-click the sample group, and select [Copy to all Individual Worksheets] from the context menu.
The shared worksheet of the sample group is copied to the worksheet of all samples.
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Setting Keyword Names for an Experiment

Using the sample keyword function allows you to set keywords for each sample. Up to 10 keyword names can be set for
each experiment and a value can be entered in each sample for keywords set in an experiment. The set keyword and
value are added as separate keywords for each sample when exporting in FCS format.
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Right-click an experiment on the [Analysis] tab, then select [Properties] from the context menu.

The [Experiment Properties] dialog appears.

1

In [Sample Keywords], enter keyword names in [Keyword 1 Name] to [Keyword 10 Name], and click [OK].

A keyword cannot be used if a keyword name is not entered (blank field).

The keyword names are configured in the experiment.

2
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Attaching a Keyword to a Sample (Sample Properties)

For keyword names configured in an experiment, you can set the value of a keyword for each sample.
The keyword value is set using the properties dialog of the sample.
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Right-click a well or tube on the [Analysis] tab, then select [Properties] from the context menu.

The sample properties dialog appears.

1

In [Sample Keywords], enter a keyword value in [Value] for any of the [Keyword 1 Name] to [Keyword 10
Name] keyword names, and click [OK].

2

Enter a keyword value, then click [OK].3
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Attaching a Keyword to a Sample (Layout Editor)

For keyword names configured in an experiment, you can set the value of a keyword for each sample.
The keyword value is set using the plate layout editor dialog.

Click [Layout Editor] in the [Plate] group on the [Analysis] tab of the ribbon.

The [Layout Editor] dialog appears.

1

Select a sample in the area on the left side, enter a keyword value for the sample in [Value] of any item with
a keyword name set among [Keyword 1 Name] to [Keyword 10 Name] in [Sample Keywords], and click
[Close].

The keyword is set for the sample.

2
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Editing and Importing Plate Metadata

You can export metadata for a plate to a CSV file, edit the metadata using Microsoft Excel, and then import the edited
metadata.

Select a plate whose metadata you want to export in the experiment list, then click [Export Layout to CSV
File] on the [Analysis] tab of the ribbon.

You can also perform the same operation by right-clicking the plate and selecting [Export Layout to CSV File] from
the context menu.

The [Export Layout to CSV File] dialog appears.

1

Specify the file export destination, then click [Export].

The metadata is exported as a CSV file.

2

Open and edit the exported file in Microsoft Excel or other software.

Example: Plate metadata

3

Right-click a plate in the experiment list, then select [Import Layout from CSV File] from the context menu.

The [Import Layout from CSV file] dialog appears.

4

Specify the metadata file to import, check the file contents, and click [Import].

Updated locations are displayed with a green background, warning locations with a yellow background, and error
locations with a red background.
Changes to sample groups are not reflected.

5
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The metadata is imported.

175



Help Guide

SFA - Life Sciences Cloud Platform

Configuring the Virtual Filter Function

Using the virtual filter function allows you to set the detection channel range for each fluorochrome.
These settings are used when spectral unmixing is off.

Click [Unmixing Settings] in the [Unmixing] group on the [Unmixing] tab of the ribbon.

The [Unmixing Settings] dialog appears.

1

Right-click the fluorochrome whose channels you want to adjust on the [Color Panel] tab, then select [Edit
Fluorochrome] from the context menu.

The [Edit Fluorochrome] dialog appears.

2

Set the channels for which the virtual filter is applied.

Dragging either side of the channel marker allows you to extend or reduce the set of contiguous channel markers.
Dragging within a channel cell moves all channel cells.
You can also change the laser to apply.

3
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Hint

To restore the default settings, click [Reset].

Click [Close].

The settings are reflected in the fluorochrome list.

4

Click [Close] in the [Unmixing Settings] dialog to close the dialog.5
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Adding a New Fluorochrome

Click [Unmixing Settings] in the [Unmixing] group on the [Unmixing] tab of the ribbon.

The [Unmixing Settings] dialog appears.

1

Enter a fluorochrome name, then click [Add].

The [Add New Fluorochrome] dialog appears.

2

Set each item, then click [OK].

[Preview] displays an image representing the spectrum waveform for the currently selected fluorochrome.

3
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[Name]: Enter the name of the fluorochrome.
[Laser]: Selects the laser to use.
[Start Channel] / [End Channel]: Enter the range of valid channels for the fluorochrome.
[Color]: Selects the display color.
[Emission Spectrum]: Selects the fluorochrome spectrum image waveform. Selecting the waveform displays a
preview.

[Blank]: Does not display a waveform.
[Copy from another fluorochrome]: Uses another waveform registered in the database. When selected, enter
the name of the fluorochrome.
[Load from CSV file]: Loads waveform information from a CSV file. When selected, click [Browse] to specify the
CSV file. The CSV file has the following format.
Wavelength, Intensity
Example: 500, 0.01
501, 0.02
502, 0.04
…
625, 1
…
799, 0.01
800, 0

The fluorochrome is added.
The added fluorochrome is also automatically added to the fluorochrome drop-down list in the [Unmixing Settings]
dialog.
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Customizing the Display Color of a Fluorochrome

Click [Color] in the [Add New Fluorochrome] dialog, then click [Advanced] in the [Available Colors] color
picker.

The dialog displays the following palette.

1

Specify a color.2
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Click anywhere outside the palette to close the palette.3
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Running Batch Analysis

If a worksheet for which analysis has been completed already exists, the analysis for multiple samples can be performed
at the same time.

On the [Experiment] panel, select the experiment, plate, or sample group as the target for batch analysis,
and click [Batch Analysis] on the [Analysis] tab of the ribbon.

You can also perform the same operations by right-clicking an experiment, plate, or sample group and selecting
[Batch Analysis] from the context menu.

The [Batch Analysis] dialog appears.

1

Check the target displayed in [Batch Analysis], and click [Start].

[Export Statistics CSV]: Exports the contents of the statistics table as a CSV-format file.
[Print Worksheet]: Prints the contents of the worksheet.

2

Click [Browse] for [Output Folder] and specify the export destination folder.3
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Hint

To change the destination printer or paper size for batch analysis, configure the printer and paper settings in [Preference
Settings]. For details about [Preference Settings], see “[Preference Settings] Dialog ([Printer]).”
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Click [Start].

When the batch analysis is completed, a confirmation message appears.

4

Click [OK].5

Click [Close] to close the [Batch Analysis] dialog.6
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Exporting an FCS File

The plate and tube data can be exported as an FCS-format file. The data is exported to cloud storage, and the download
URL is delivered as a notification.

Select the data you want to export in the [Experiment] panel.1

Click [Export to FCS File] of [Batch Processing] on the [Analysis] tab of the ribbon.

You can also perform the same operation by right-clicking an experiment, plate, tube, or sample group in the
[Experiment] panel and selecting [Export to FCS file] from the context menu.

The [FCS File Export] dialog appears.

2

Place a check mark in the plates or sample tubes to export, specify the file format, specify the export
destination, and click [Export].

3
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[Pulse Type (for fluorescence)]: Select the pulse type.
[Data Type]: Select the data type for the FCS file to be exported.
[FCS File (Virtual Filter applied) (by Sample Group)]: Place a check mark in the checkbox to export the
fluorochrome data acquired from the virtual filter without performing spectral unmixing.
[Unmixed FCS File (by Sample Group)]: Place a check mark in the checkbox to perform spectral unmixing and
export the resulting fluorochrome data.
[Optional FCS Text Segment Keywords (by sample)]: Set metadata for each sample.

Note
Keywords and their values set using the sample keyword function are exported automatically.

[FCS version]: Selects the FCS file version.

Note
Check the manual of the analysis software, select the FCS file version, and export.

The FCS file is exported to cloud storage.
When exporting is completed, a download notification is delivered as a notification.
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Click [Detail] in the download notification.4

Access the URL contained in the [Detail Notification] dialog, then download the data.5
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Exporting an Experiment

You can export experiment data in exdat format, then use it in another application. The exported data does not include
the advanced analysis results.

Display the [Experiment] pane on the [File] tab, then click [Export].

The [Export Experiment Data] dialog appears.

1

Select the experiments to be exported, then click [Export].

For details about each item, see “[Export Experiment Data] Dialog.”

The experiment data is exported.

2
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Click [Close] to close the dialog.3
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Maintaining the Spectral Reference Library

The following operations are supported for the spectral reference library.

Exporting/importing spectral reference data
Deleting spectral references from the library

To export spectral reference data
Display the [Library] window, then click [Export] on the [Library] tab of the ribbon.

The [Browse For Folder] dialog appears.
Specify the export destination folder, then click [OK]. The spectral reference data is exported.

To import spectral reference data

To delete a spectral reference from the library
Right-click the spectral reference you want to delete, then select [Delete] from the context menu.

Click [Import] on the [Library] tab of the ribbon.

The [Import Spectral Reference Dialog] dialog appears.

1

Specify the spectral reference data to import, then click [Import].

The spectral reference data is imported.

2

When the importing completed message appears, click [OK].3

Click [Close] to close the dialog.4
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Displaying the License Information

This topic describes how to display license information.

Hint

The license information can also be displayed by selecting “Life Sciences Cloud Platform” － “SFA License Manager” from the
Start menu of Windows to start SFA License Manager.

Open the [File] tab, then click [License Information].

SFA License Manager starts.

1
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For details about the operation to register and activate a license, see “Activating a License.”
For details about the operation to add users to a license, see “Adding Users to a License.”
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Checking the License Information and Usage Status

The license type and usage status can be checked in [License List] of SFA License Manager. The detailed information
can be checked, as required.

To check the detailed information of a license

Select the license for which to check the detailed information in [License List], then click [Show Details].1
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To show usage information for each licensed user

Hint
Only the license owner or administrator can perform this operation.

The [License Details] dialog appears.

[License Details]: Displays the license ID, license type, and usage status.
[License Owner / Administrators]: Displays the license owner and administrators. For details about adding an
administrator, see “Adding an Administrator to a License.”
[Option Licenses]: Adds an option license. For details about the operation, see “Adding an Option License.”
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Select the license for which to show usage information in [License List], then click [Show Usage] to display the [User
Usage] dialog.
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Adding an Administrator to a License

Up to three administrators can be added to a license. An administrator can add users to a license.
Only the license owner can perform this operation.

Hint
When adding an unregistered user as an administrator, a user creation email is sent to that user. Create an account from the
sign-up URL included in the received email.

Select the license to which to add an administrator in [License List], then click [Show Details].

The [License Details] dialog appears.

1

Click [Add Administrator].2
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The [Add License Administrator] dialog appears.

Enter the email address of the user to be assigned the administrator authority, then click [OK].

The administrator is added to the [License Owner / Administrators] list.

3
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To remove an administrator
Select the administrator to remove in the [License Owner / Administrators] list, then click [Remove Administrator].
When the confirmation message appears, click [OK].
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Adding an Option License

This topic describes the procedure to add an option license.
Only the license owner and the administrators can perform this operation.

For details about option license types, see “License.”

Purchase an option license, and acquire the license ID.

Determine the option license to purchase, then send a purchase order by email to your Sony distributor. When a
license is purchased, a license ID is issued and sent to the license owner by email.

1

Start SFA License Manager.2

Select the license to which to add an option license in [License List], then click [Show Details].

The [License Details] dialog appears.

3

Click [Add Option].4
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The [Add Option License] dialog appears.

Enter the license ID, then click [OK].

The information of the option license to be added appears.

5

Check the information, then click [OK].

Hint

An extra storage license with an expiration date which is the same or after that of the license must be added.

The option license is added to the [Option Licenses] list.

6

200



5-051-744-11(1) Copyright Sony Corporation

Check that amounts in [CPU [hours]] and [Storage [GB]] of [License Details] have increased in accordance
with the added license, then click [OK].

7
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Viewing the Notification Page from Life Sciences Cloud Platform

The service operation status, notifications, and various other information for Life Sciences Cloud Platform are notified
and made available on the following page.
https://helpguide.sony.net/med/sfa_info/v1/en/index.html
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[Information] Window

The [Information] window is used to perform tasks such as configuring the default settings for each user, checking the
usage status, and managing workspaces and projects.
The [Information] window is displayed by clicking [Information] on the [File] tab.

[Preference Settings]
Various default function settings can be saved by each user in user preferences. The values set here become the default
values used for each function.
Clicking this button displays the [Preference Settings] dialog. See “[Preference Settings] Dialog (Overview)”.
[Workspace and Project Information]
Allows you to manage workspaces and projects, create projects, and so on.
Clicking this button displays the [Workspace and Project Information] dialog. See “[Workspace and Project Information]
Dialog”.
[Usage Information]
Allow you to check the license information and usage information of Life Sciences Cloud Platform.
Clicking this button displays the [Usage Information] dialog. See “[Usage Information] Dialog”.
[License Information]
Allows you to check the license information and usage status. If you are the license owner, you can add users to the
license.
Clicking this button displays SFA License Manager.

For details about the operation, see “Starting SFA License Manager (for the First Time).”

[Login Mode Setting]
Allows you to check the login mode and change the setting.
Clicking this button displays the [Login Mode Setting] dialog. See “[Login Mode Setting] Dialog”.
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[Print] Window

The [Print] window is used to print analysis results and other information displayed on the worksheet.
The [Print] window is displayed by selecting a plot or other object you want to print on the worksheet, then clicking [Print]
on the [File] tab.
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[Print] button
Sends the print job to the printer.

1.

[Print]
Place a check mark in the [Use Advanced Settings] checkbox to set advanced printer settings.

2.

Print preview
Displays a preview image of the print job.

3.

[Settings]
Sets the paper size and page orientation.

4.

[Printer]
Selects the printer for printing.

5.
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[Experiment] Window

The [Experiment] window is used to import and export experiment data.
The experiment data of the ID7000 Spectral Cell Analyzer can also be imported from this window.
The [Experiment] window is displayed by clicking [Experiment] on the [File] tab.

[Import]
Allows you to import the data of an experiment in exdat format and upload it to cloud storage, then view the analysis
results in the Spectral Flow Analysis software.
Clicking this button displays the [Import Experiment Data] dialog. See “[Import Experiment Data] Dialog”.
The importing of data exported from the ID7000 Spectral Cell Analyzer is also performed in this dialog.

For details about the operation, see “Importing Data.”

[Export]
Allows you to export the data of an experiment in exdat format.
Clicking this button displays the [Export Experiment Data] dialog. See “[Export Experiment Data] Dialog”.
Experiment data analyzed in this software can also be exported and then used in the Spectral Flow Analysis Software or
the ID7000 Software. (Worksheet information of Advanced Analysis is removed.)

For details about the operation, see “Exporting an FCS File.”
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[Help] Window

The [Help] window is used to display the help guide and check the version information of the Spectral Flow Analysis
software.
The [Help] window is displayed by clicking [Help] on the [File] tab.
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[Open Help Guide]
Displays the help guide.

1.

Version information
Displays the version information of the Spectral Flow Analysis software.
You can also view the “End User Agreement” and “Privacy Settings / Privacy Policy.”

2.
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[Preference Settings] Dialog (Overview)

The [Preference Settings] dialog allows the default values for each function to be specified according to preference for
each user. User preferences are loaded automatically, eliminating the need for some configuration settings when you
want to perform acquisition, analysis, or sorting.
The [Preference Settings] dialog is displayed by clicking [Information] – [Preference Settings] on the [File] tab.

Menu items

[Worksheet]: Sets the default settings related to the worksheet. For details about each item, see “[Preference
Settings] Dialog ([Worksheet]).”
[Data Management]: Specifies the export destination folders for various data. For details about each item, see
“[Preference Settings] Dialog ([Data Management]).”
[Printer]: Configures settings related to printers. For details about each item, see “[Preference Settings] Dialog
([Printer]).”

1.
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[Reset]
Returns the settings to the default settings of the Spectral Flow Analysis software.

2.

[Preference Settings]
You can import the preference settings of another user and export your own preference settings.

[Import]: Imports user data.
[Export]: Exports the current settings as preference settings.

3.

[Cancel]
Cancels the settings and closes the dialog.

4.

[OK]
Saves the settings and closes the dialog.

5.
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[Preference Settings] Dialog ([Worksheet])

[Worksheet] in the [Preference Settings] dialog is used to specify the default settings related to worksheets.
The [Preference Settings] dialog is displayed by clicking [Information] – [Preference Settings] on the [File] tab.

[Plots]

[Display Events in Analysis]
Selects the number of events to display on plots during analysis.

[Gate]
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[Label Font Size]
Selects the font size of text labels shown on gates. You can check the size in [Preview].

[Default Axis Settings for Density/Dot/Contour/Histogram]

Sets the default axis settings for density plots, dot plots, contour plots, and histogram plots.
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[FSC Axis Parameters]
Sets the forward scatter (FSC) axis parameters.

[Pulse]: Selects the pulse type.
[Axis Type]: Selects the default scale type of an axis.
[Axis Range]: Sets the axis scale range by specifying the minimum value, negative area, or maximum value
according to the axis scale type.

1.

[SSC Axis Parameters]2.
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[Default Settings for Spectrum / Ribbon Plots]

Sets the default settings for spectrum plots and ribbon plots.

[Default Settings for Contour Plots]

Sets the side-scatter (SSC) axis parameters.

[Pulse]: Selects the pulse type.
[Axis Type]: Selects the default scale type of an axis.
[Axis Range]: Sets the axis scale range by specifying the minimum value, negative area, or maximum value
according to the axis scale type.

[Fluorescence Axis Parameters]
Sets the fluorescence data axis parameters.

[Pulse]: Selects the pulse type.
[Axis Type]: Selects the default scale type of an axis.
[Axis Range]: Sets the axis scale range by specifying the minimum value, negative area, or maximum value
according to the axis scale type.

3.

[X Axis (Spectrum Plots)]
Selects the X-axis parameter.

1.

[Y Axis]
Selects the Y-axis pulse parameter and scale type.

2.

[Spectrum Display]
Sets the spectrum display mode.

[Display All]: Displays all density data.
[Display High Density]: Displays the high-incidence spectral information, omitting low-incidence events, to make
the display easier to view.

3.

213



Sets the default settings for contour plots.
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[Method]
Selects the division method.

[Probability]: Draw contour lines so that each area between contour lines contains the same number of events.
[Linear]: Draw contour lines so that each area between contour lines contains the maximum density divided
linearly.
[Log]: Draw contour lines so that each area between contour lines contains the maximum density divided
logarithmically.

1.

[Percentage]
Selects the percentage division of the contour lines. The larger the number, the larger the distance between contour
lines.

2.

[Color Scheme]
Selects the color scheme.

[Multicolor]: High-density contour lines are shown in red, and low-density contour lines are shown in blue.
[Black/White]: Display in black and white.

3.

[Show Outliers]
Place a check mark here to display outlier events outside the outermost contour lines as dots.

4.
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[Preference Settings] Dialog ([Data Management])

[Data Management] in the [Preference Settings] dialog is used to specify the export destination folders for various data.
The [Preference Settings] dialog is displayed by clicking [Information] – [Preference Settings] on the [File] tab.

[Default Export Folder for Plate Layout File]
Specifies the destination for exporting the plate metadata as a CSV file in the [Export Layout to CSV File] dialog.

For details, see “Editing and Importing Plate Metadata.”

[Default Export Folder for Experiment]
Specifies the destination for exporting the experiment data in the [Export Experiment Data] dialog.

For details, see “Exporting an Experiment.”

[Default Export Folder for Spectral Reference]
Specifies the destination for exporting an autofluorescence spectral reference in the [Unmixing Settings] dialog.

For details, see “[Unmixing Settings] Dialog ([Color Panel] Tab).”

[Default Export Folder for Bach Analysis]
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Specifies the destination for exporting the contents of the statistics table as a CSV-format file in the [Batch Analysis]
dialog.

For details, see “Running Batch Analysis.”
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[Preference Settings] Dialog ([Printer])

[Printer] in the [Preference Settings] dialog is used to configure the default settings related to printers.
The [Preference Settings] dialog is displayed by clicking [Information] – [Preference Settings] on the [File] tab.

[Printer]
Specifies the print output destination printer.
[Settings for worksheet]
Specifies the paper size and page orientation for printing worksheets.
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[Usage Information] Dialog

The [Usage Information] dialog is used to check the license information and usage information of Life Sciences Cloud
Platform.
The [Usage Information] dialog is displayed by clicking [Information] – [Usage Information] on the [File] tab.

[Workspace List]
Displays a list of the information of the workspaces to which you belong.
When you select a workspace, the projects in which you participate are displayed in [Project List].
[Project List]
Displays a list of the information of the projects in which you participate in the workspace selected in [Workspace List].
[Close]
Closes the dialog.
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[Workspace and Project Information] Dialog

The [Workspace and Project Information] dialog is used to manage workspaces and projects, create a project, and so
on.
The [Workspace and Project Information] dialog is displayed by clicking [Information] – [Workspace and Project
Information] on the [File] tab.

[Region / Workspace]
Display the workspace that you select and the region of the workspace.
You can rename a workspace that you own. To do so, edit the name and click [Save].
[Owner]
Displays the owner of the workspace.
[Administrators]
Displays the administrators of the workspace.
[Users]
To click [Show Workspace Users], allows you to check the users participating in a workspace you own. In addition,
the owner or an administrator of the workspace can invite a user to become a user of the workspace.
Clicking this button displays the [Show Workspace Users] dialog. See “[Show Workspace Users] Dialog”.

1.

[Project List]2.
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Displays a list of the projects located in the workspace selected in [Workspace List]. In [Properties], information about
the workspace selected in the list is displayed.
[Name]
Displays the name of the project. You can rename a project located in a workspace that you own. To do so, edit the
name and click [Save].
[Owner]
Displays the owner of the project.
[Administrators]
Displays the administrators of the project.
[Users]
To click [Show Workspace Users], allows you to check the users participating in the project selected in the list, and
add or delete a user to/from the project. Only the owner or an administrator of the project can add and delete project
users. Clicking this button displays the [Show Project Users] dialog. See “[Show Project Users] Dialog”.
[Add]
Adds a new project. Clicking this button adds “New Project” to the list. Only the owner or an administrator of the
workspace can add a project.
[Delete]
Deletes the project selected in the list. Only the owner or an administrator of the workspace can delete a project.
[OK]
Saves the settings and closes the dialog.

3.

[Cancel]
Cancels the settings and closes the dialog.

4.
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[Show Workspace Users] Dialog

The [Show Workspace Users] dialog is used to check the users participating in a workspace you own, and invite a user
to become a user of the workspace.
The [Show Workspace Users] dialog is displayed by clicking [Show Workspace Users] on the right side of [Workspace
List] in the [Workspace and Project Information] dialog.

[Workspace]
Displays the workspace name and a list of the participating users.

1.

[Invite]
Allows you to invite another user to the workspace. Clicking this button displays the [Invite User] dialog. See “[Invite
User] Dialog”.

2.

[Delete]
Deletes the user selected in the list from the workspace.

3.

[Change Role]4.
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Allows you to change the role that the user selected in the list has in this workspace. Clicking this button displays the
[Change Project Role] dialog. See “[Change Project Role] Dialog”.
There are the following roles for a workspace.

[Owner]: The owner of the workspace can manage the workspace users and create projects. The owner of the
workspace is the owner of the projects in the workspace.
[Administrator]: An administrator of the workspace can manage the workspace users and create projects. An
administrator of the workspace who has created a project is the administrator of that project.
[User]: A user of the workspace can be added as a user of a project in the workspace.

[Close]
Closes the dialog.

5.
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[Show Project Users] Dialog

The [Show Project Users] dialog is used to check the users who are users of the project and add users to the project.
The [Show Project Users] dialog is displayed by clicking [Show Project Users] in the [Workspace and Project Information]
dialog.

[Project]
Displays the project name and a list of the participating users.

1.

[Add Users]
Allows you to add a user to the project. Clicking this button displays the [Add Project User] dialog. See “[Add Project
User] Dialog”.

2.

[Remove from Project]
Removes the user selected in the list from the project.

3.

[Change Role]4.
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Allows you to change the role that the user selected in the list has in this project. Clicking this button displays the
[Change Project Role] dialog. See “[Change Project Role] Dialog”.
There are the following roles for a project.

[Owner]: The owner of a project can add and delete project users, and change their roles. The owner of the
workspace is the owner of the project.
[Administrator]: An administrator of a project can add and delete project users, and change their roles.
[User]: A user can view, analyze, add, and delete the data in the project.

[Close]
Closes the dialog.

5.
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[Add Project User] Dialog

The [Add Project User] dialog is used to add users to the project. They are added as users of the project. The role can
be changed after adding a user.
The [Add Project User] dialog is displayed by clicking [Add Users] in the [Show Project Users] dialog.

[Project]
Displays the project name and a list of the users who can participate in the project.

Hint
For a user to join a project, the user must be a user of the workspace. For details about the operating procedure, see “Adding
Users to a Workspace.”

[Add]
Adds the user selected in the list to the users of the project.
[Close]
Closes the dialog.
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[Change Project Role] Dialog

The [Change Project Role] dialog is used to change the role of a user in the workspace and project.
The [Change Project Role] dialog is displayed by clicking [Change Role] in the [Show Workspace Users] dialog or [Show
Project Users] dialog.

[Workspace] or [Project]
Displays the workspace or project name.
[User]
Displays the email address for the user.
[Role]
Selects the role of the user.
[OK]
Saves the settings and closes the dialog.
[Cancel]
Cancels the settings and closes the dialog.

5-051-744-11(1) Copyright Sony Corporation

226



Help Guide

SFA - Life Sciences Cloud Platform

[Invite User] Dialog

The [Invite User] dialog is used to set a user to be invited to the workspace. After the user agrees, the user is added as a
user of the workspace.
The [Invite User] dialog is displayed by clicking [Invite] in the [Show Workspace Users] dialog.

[Email address]
Enter the email address of the user you want to invite. Only the user who owns the license of Spectral Flow Analysis can
invite.
[Project]
Place check marks in the checkboxes of the projects you want the user to join.
[Invite]
Invites the user. An invitation email for the workspace is issued to the specified email address. After the user agrees, the
user is added to the workspace.
[Close]
Closes the dialog.
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[Login Mode Setting] Dialog

The [Login Mode Setting] dialog is displayed by clicking [Information] – [Login Mode Setting] on the [File] tab.
The [Login Mode Setting] dialog allows you to check the login mode and clear the setting. If the login mode setting is
cleared, the setting dialog will appear when Spectral Flow Analysis starts next time.

[Current Login Mode]
Displays the current login mode.
[Clear current mode]
Place a check mark here and click [OK] to clear the login mode setting.
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[Import Experiment Data] Dialog

The [Import Experiment Data] dialog is used to import the data of an experiment in exdat format, and upload it to cloud
storage. After uploading completes, analysis is run automatically and the analysis results can be checked on the [View]
tab.
The importing of data exported from the ID7000 Spectral Cell Analyzer is also performed in this dialog.
The [Import Experiment Data] dialog is displayed by clicking [Experiment] – [Import] on the [File] tab.

[Import File(s)]
Specify the name of the file containing the experiment data you want to import.
[I confirmed that the import files do not contain any personal information of subjects.]
Check that the data to be imported does not contain any personal information of subjects, then place a check mark in the
checkbox.
Progress bar
Displays the import progress.
[Import]
Starts the import.
When you place a check mark in the [I confirmed that the import files do not contain any personal information of
subjects.] checkbox, this button becomes available.
[Abort]
Aborts the import.
[Close]
Closes the dialog.
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[Export Experiment Data] Dialog

The [Export Experiment Data] dialog is used to export experiment data in exdat format.
Experiment data analyzed in this software can also be exported and then used in another application.
The [Export Experiment Data] dialog is displayed by clicking [Experiment] – [Import] on the [File] tab.

[User]
Selects the owner of the experiments to export.

1.

Experiment list
Displays a list of experiments owned by the selected user.
Select the experiment(s) you want to export.

2.

[Move] / [Move All]
Clicking [Move] adds the experiment data selected in the experiment data list to the [Exporting Experiment List].
Clicking [Move All] adds all the experiment data in the experiment data list to the [Exporting Experiment List].

3.

[Exporting Experiment List]
Lists the experiments to be exported.

4.

[Clear]
Clears the [Exporting Experiment List].

5.
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[Remove]
Removes the selected experiment from the [Exporting Experiment List].

6.

[Output Folder]
Specifies the export destination folder. Click [Browse] to select the destination folder.

7.

Progress bar
Displays the export progress.

8.

[Export]
Starts exporting.

9.

[Cancel]
Cancels the export and closes the dialog.

10.

[Close]
Closes the dialog.

11.
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[View] Tab

The [View] tab is used to view the imported experiment data.

Hint

You can only view data on the [View] tab. If you want to analyze the data, it is necessary to switch to the [Analysis] tab. For
details about the operating procedure, see “Opening the [Analysis] Tab.”

[Experiment Explorer] pane
Selects data to view. You can also search experiments by date and keyword.
For details about the operating procedure, see “Searching Experiments.”

1.

Experiment list
Displays the data of acquired experiments, analysis samples, and reports in list view.

2.

Worksheet
This worksheet contains the data of the selected wells/tubes. Click the tab of the worksheet you want to view.
For details about the tools and information display that are common for worksheets, see “Toolbar” and “Status Bar.”

3.

[Start Analysis]
Switches the experiment selected in the experiment list to the [Analysis] tab.
This button has the same function as [Start Analysis] displayed by right-clicking an experiment.

4.
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Context menu
For details about the menu items, see “Experiments.”

5.

[Plate] panel
Displays a list of wells/tubes. You can switch the display to list view or map view.
The icon of a well/tube varies depending on the worksheet mode.

: [Shared] mode
: [Individual] mode

[Color coded by]
You can sort wells by color for selected metadata.

Displays the [Layout Editor] dialog where you can view the plate layout, sample information, metadata, and other
information. See “[Layout Editor] Dialog”.

6.
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Structure of [Analysis] Tab

The [Analysis] tab is used to analyze the data in the imported experiment.
The [Analysis] tab has the following structure.

Tabs (ribbon)
The ribbon has the following tabs (tabs vary depending on the current selection).

[Analysis] tab (See “[Analysis] Tab (Ribbon)”.)
[Unmixing] tab (See “[Unmixing] Tab (Ribbon)”.)
[Worksheet Tools] tab (See “[Worksheet Tools] Tab (Ribbon)”.)
[Plot Tools] tab (See “[Plot Tools] Tab (Ribbon)”.)
[Gate Tools] tab (See “[Gate Tools] Tab (Ribbon)”.)

1.

Worksheet
This worksheet contains the data of the selected wells/tubes.
For details about the tools and information display that are common for worksheets, see “Toolbar” and “Status Bar.”

2.

Context menu
For details about the menu items, see “Worksheet.”

3.

Statistics Table
Displays statistics calculated automatically from acquired data.
For details about each item, see “Statistics Table.”

4.
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Control pane
Selects a sample for analysis.
For details about the operating procedure, see “Selecting a Sample for Analysis.”

5.
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[Analysis] Tab (Ribbon)

The [Analysis] tab of the ribbon has the following buttons.

[Plate] group
These buttons allow you to delete a plate from an experiment or edit plate settings.
[Layout Editor]
Allows you to edit the layout of the plate selected in the [Experiment] panel. Clicking this button displays the [Layout
Editor] dialog. See “[Layout Editor] Dialog”.
[Export Layout to CSV File]
Allows you to export the metadata of the plate selected in the [Experiment List] panel to a file in CSV format. Clicking
this button displays the [Export Layout to CSV File] dialog.

Allows you to edit information related to the plate. Clicking this button displays the plate properties dialog. See “Plate
Properties Dialog”.

1.

[Sample]
These buttons are used for operations on wells.
[Copy]/[Paste]
Copies and pastes the selected well.
[Export Instrument Settings]
Exports the instrument settings as a file.
[Instrument Settings]
Allows you to configure instrument settings related to lasers, detectors, and flow rates. Clicking this button displays
the [Instrument Settings] dialog. See “[Instrument Settings] Dialog”.
[Stopping Condition]
Allows you to view the data acquisition stopping condition. Clicking this button displays the [Stopping Condition]
dialog.

Allows you to edit information related to the well. Clicking this button displays the well properties dialog. See “Well
Properties Dialog”.

2.

[Batch Processing]
These buttons are used to run analysis on multiple samples at the same time.
[Batch Analysis]
Runs batch analysis for the selected experiments, plates, and sample groups. Clicking this button displays the [Batch
Analysis] dialog.

For the operating procedure, see “Running Batch Analysis.”

[Export to FCS File]

3.
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Exports the acquisition data for the selected experiments, plates, and sample groups as an FCS file. Clicking this
button displays the [FCS File Export] dialog.

For the operating procedure, see “Exporting an FCS File.”
[Display Events]
Configures settings related to events displayed on plots.
[Analysis]
Selects the number of events to display on plots during analysis.

4.

[Analysis]
Terminates or restarts the analysis server.
[Terminate Analysis]
Terminates the analysis server when it is running. Clicking this button, a message appears to prompt you to terminate
the analysis server. The analysis server terminates to click [OK].

Hint
To forcibly terminate the analysis server while performing lengthy process such as advanced analysis, click [Force Terminate]
button which is shown on the data saving dialog. Please note that the analysis results may be incomplete when the server is
forcibly terminated.

[Restart Analysis]
Restarts the analysis server.

5.
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[Unmixing] Tab (Ribbon)

The [Unmixing] tab of the ribbon has the following buttons.

[Unmixing]
These buttons are used to calculate the fluorescence unmixing matrix and to apply the matrix.
[Matrix]
Selects the unmixing matrix.
[Use common matrix]
Place a check mark in the checkbox to apply the unmixing matrix to all the samples in the sample group.
[Calculate Matrix]
Calculates the spectral unmixing matrix.
[Apply]
Selects whether fluorescence unmixing is applied to plots on the worksheet. Clicking this button toggles unmixing
on/off. This setting is reflected on the unmixing settings.
[Unmixing Settings]
Allows you to adjust the fluorescence unmixing. Clicking this button displays the [Unmixing Settings] dialog. See
“[Unmixing Settings] Dialog ([Color Panel] Tab)”.

1.

[Spectral Reference]
These buttons are used to adjust spectral references and register spectral references in the library.
[Spectral Reference Adjuster]
Allows you to manually correct the fluorescence unmixing by adjusting the spectral reference of the selected matrix.
Clicking this button displays the [Spectral Reference Adjuster] dialog.

For details about the operating procedure, see “Adjusting Spectral Unmixing Manually (Spectrum).”

[Unmixing Viewer]
You can check the results of spectral unmixing by displaying a list of plots for each fluorochrome combination.
Clicking this button displays the [Unmixing Viewer] dialog.

For details about the operating procedure, see “Checking Fluorochrome Unmixing Results Summary.”

[Load Spectral Reference]
Allows you to load a spectral reference from the spectral reference library into the selected matrix. Clicking this
button displays the [Load Spectral Reference] dialog. See “[Load Spectral Reference] Dialog”.
[Add to Library]
Adds the spectral reference to the library.

2.

[Autofluorescence]
This button is used to find autofluorescence populations.
[Autofluorescence Finder]

3.
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Allows you to find the autofluorescence spectrum in acquisition data by searching for the autofluorescence
populations.
Clicking this button displays the [Autofluorescence Finder] dialog.

For details about the operating procedure, see “Finding Autofluorescence Populations.”
[Fluorochrome]
This button is used to manage the fluorochrome database.
[Fluorochrome Database]
Allows you to edit the fluorochrome database. Clicking this button displays the [Fluorochrome Database] dialog. See
“[Fluorochrome Database] Dialog”.

4.
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[Worksheet Tools] Tab (Ribbon)

The [Worksheet Tools] tab of the ribbon has the following buttons.

[New Plot]
These buttons are used to add a new plot.

For details about adding plots, see “Adding Plots.”

[Density]
Adds a new density plot.
[Dot]
Adds a new dot plot.
[Contour]
Adds a new contour plot.
[Color Axis]
Adds a new color axis plot.
[Histogram]
Adds a new histogram plot.
[Spectrum]
Adds a new spectrum plot.
[Ribbon]
Adds a new ribbon plot.

1.

[Alignment]
These buttons are used to display a grid on the worksheet and to align displayed items with the grid.
[Show Grid]
Displays a grid on the worksheet.
[Snap to Grid]
Aligns the plots and statistics table with the grid when they are moved.
[Auto Arrange]
Automatically aligns the positions of the plots and statistics table.

2.

[View]
These buttons are used to make settings related to the display of plots.
[Change Palette]
Changes the display style of the selected plot.
Click this button and select the display style.

3.
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White background
White background with highlighted outlying (rare) events
Black background
Black background with highlighted outlying (rare) events

Highlighting outlying events is useful for identifying and analyzing rare events.
Zoom
Changes the display size of plots. The current zoom factor is displayed below the icon. This setting is applied to all
plots. Click this button and select the zoom factor, or use the slider to set the zoom factor.
[Statistics]
These buttons are used to make settings related to the statistics table.
[Show Table]
Shows/hides the statistics table.
[Edit]
The statistics in the table can be customized. Clicking this button displays the [Statistics Editor] dialog. See
“[Statistics Editor] Dialog”.
[Export Statistics]
Exports the contents of the statistics table as a file in CSV format.

4.

[Gates]
This button is used to manage and configure gates.

For details about adding gates, see “Editing Gates.”

[Gate Manager]
Allows you to manage and configure the gates set for the selected sample tube. Clicking this button displays the
[Gate Manager] dialog. See “[Gate Manager] Dialog”.

5.

[Overlay]
This button is used to display spectral data for the selected plots overlaid.

For details about the operation, see “Displaying Multiple Spectral Data Overlaid.”

[Overlay Worksheet]
Displays the overlay worksheet.

[Half Worksheet View]: Displays the overlay worksheet in the bottom half of the worksheet.
[Full Worksheet View]: Displays the overlay worksheet occupying the full area of the worksheet.
[Hide Overlay Worksheet]: Hides the overlay worksheet.

6.

[Print]
This button is used to print the worksheet.
[Print]
Allows you to print the content displayed on the worksheet.
Clicking this button displays the [Print] window. See “[Print] Window”.

7.
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[Plot Tools] Tab (Ribbon)

The [Plot Tools] tab of the ribbon has the following buttons.

For details about the operating procedure, see “Adding Plots.”

[Plot Type]
These buttons are used to change the plot type.
This item can be applied to multiple selected plots on the worksheet.
[Density]/[Dot]/[Histogram]/[Contour]/[Color Axis]
Changes the type of the selected plot.

Hint
Spectrum plots cannot be modified.

1.

[Edit]
These buttons are used to duplicate and delete plots.
[Duplicate Plot]
Duplicates the selected plot or statistics table within the worksheet.
[Remove Plot]
Removes the selected plot.

Displays the properties for the selected plot. You can change the setting of each parameter, as required. Clicking this
button displays the [Plot Properties] dialog.

For dot plots, density plots, and histogram plots, see “[Plot Properties] Dialog (Properties for Dot Plots, Density
Plots, and Histogram Plots)”.
For contour plots, see “[Plot Properties] Dialog (Properties for Contour Plots)”.
For color axis plots, see “[Plot Properties] Dialog (Properties for Color Axis Plots)”.
For spectrum plots, see “[Plot Properties] Dialog (Properties for Spectrum Plots)”.

2.

[Scale]
These buttons are used to make settings related to the scale of the X and Y axes.
This item can be applied to multiple selected plots on the worksheet.
[X Axis]/[Y Axis]
Selects the type for the X and Y axes.

For details about the items, see “[Plot Properties] Dialog (Properties for Dot Plots, Density Plots, and Histogram
Plots).”

[Swap]
Swaps the X axis and Y axis parameters.
[Auto Adjustment (XY)]

3.
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Automatically adjusts the scale of the X axis and Y axis.
[Auto Adjustment (X Axis)]
Automatically adjusts the scale of the X axis.
[Auto Adjustment (Y Axis)]
Automatically adjusts the scale of the Y axis.
[Zoom]
Changes the magnification of plots. Click this button to turn on zoom, and then drag around the portion of the plot
you want to zoom in on to magnify that portion.
[Default Adjust]
Restores the scales to their default display.

Hint

Automatically adjusting the axis scale places the minimum and maximum values of the population near the ends of the X axis
and Y axis.

The automatic adjustment function adjusts the axis when the button is clicked. During data acquisition, events that are
detected after the axes are automatically adjusted may be off-scale. In this case, readjust the axes as required.

[View]
These buttons are used to make settings related to the display of plots.
[Spectrum Display]
Sets the spectrum display mode.

[Display All]: Displays all events.
[Display High Density]: Displays the high-incidence spectral information, omitting low-incidence events, to make
the display easier to view.

4.

[New Gate]
These buttons are used to add a new gate.

For details about the procedure to add gates, see “Adding Gates.”

[Rectangle]
Adds a rectangle gate.
[Ellipse]
Adds an ellipse gate.
[Polygon]
Adds a polygon gate.
[Quadrant]
Adds a quadrant gate. Quadrant gates are added with the intersection point of the quadrants at the position of the
mouse click.
[Linear]
Adds a linear gate to a histogram plot. Linear gates are added by dragging the mouse horizontally on the histogram
plot. The height of the reference line is for display only, and has no effect on the value of the linear gate.

5.

[Tool]
[Sync Scale and Gate]
Synchronizes the scale and gates of all plots within a sample group.
[Copy Picture]
Copies the selected plot or statistics table to the clipboard as an image so that it can be pasted in other software for
use in a report or other content.
This item can be applied to multiple selected plots on the worksheet.

6.
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[Gate Tools] Tab (Ribbon)

The [Gate Tools] tab of the ribbon has the following buttons.

[Edit]
These buttons are used to edit the selected gate.
[Remove Gate]
Removes the selected gate.
[Gate Manager]
Allows managing and configuring the selected gate. Clicking this button displays the [Gate Manager] dialog. See
“[Gate Manager] Dialog”.

Displays the properties of the selected gate. You can change the setting of each parameter, as required. Clicking this
button displays the [Gate Properties] dialog. See “[Gate Properties] Dialog”.

1.

[Label]
These buttons make settings related to gate labels.
[Font Size]
Selects the font size of text.
[Statistic]
Selects the statistic information that is displayed for gates.

2.

[Color]
This group is used to change the colors of gates.
Color Palette
Changes the color of the selected gate.
[Edit color]
Changes a color in the palette to a custom color. Click a color in the color palette, click the [Edit Color] button, then
select a new color, and click [Apply].

3.

[New Child Plot]
These buttons are used to add a new child plot.
[Density]
Adds a new density plot.
[Dot]
Adds a new dot plot.
[Contour]
Adds a new contour plot.
[Color Axis]
Adds a new color axis plot.
[Histogram]
Adds a new histogram plot.
[Spectrum]
Adds a new spectrum plot.

4.
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[Ribbon]
Adds a new ribbon plot.
[Data Quality]
Configures settings related to data quality.
[Data Cleaning]
Removes events containing noise and outliers.

For details about the operation, see “Removing Events Containing Noise and Outliers (Data Cleaning Function)”
in “Analysis Using the Dimensionality Reduction Function.”

5.

[Clustering]
Analyzes data by using the clustering function to extract a cell population automatically.

For details about the operation, see “Analyzing by Learning Samples” in “Analysis Using the BL-FlowSOM
Function.”

[BL-FlowSOM]
Analyzes data by using BL-FlowSOM. Clicking this button displays the [BL-FlowSOM] dialog. See “[BL-FlowSOM]
Dialog”.

6.

[Dimensionality Reduction]
Analyzes data by using the dimensionality reduction function to “compress” multi-dimensional cell data to display it
on a two-dimensional plot.

For details about the operation, see “Analyzing by Learning Samples” in “Analysis Using the Dimensionality
Reduction Function.”

[UMAP]
Analyzes data by using UMAP. Clicking this button displays the [UMAP] dialog. See “[UMAP] Dialog”.
[FIt-SNE]
Analyzes data by using FIt-SNE. Clicking this button displays the [FIt-SNE] dialog. See “[FIt-SNE] Dialog”.

7.
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[Layout Editor] Dialog

The [Layout Editor] dialog is used to edit the sample information and add keywords to the sample.
The [Layout Editor] dialog is displayed by clicking [Layout Editor] of [Plate] tab on the [Analysis] tab of the ribbon.

View
You can switch the display to list view or map view.
The icon of a well/tube varies depending on the worksheet mode.

: [Shared] mode
: [Individual] mode

1.

[Color coded by]
You can sort wells by color for selected metadata.

Sample Group
Cell
Condition

2.
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[Sample Information]
You can edit information about a sample.
[Name]
Enter the name of the well.
[Cell (optional)]
Enter information about the cell, as required.
[Condition (optional)]
Enter the condition of the sample, as required.
[Memo (optional)]
Enter a comment, as required.

3.

[Sample Keywords]
You can edit the sample keywords for the keyword names set in an experiment.
[Name]
Displays the keyword names configured in the experiment.
[Value]
Enter a sample keyword.

4.

[Sample Status]
Displays the acquisition status of the sample.
[Status]
Displays the acquisition status of the sample.
[Acquisition Date]
Displays the acquisition date and time.
[Worksheet Mode]
Displays the worksheet mode.
[Unmixing Cache]
Displays whether data for which fluorescence unmixing calculation has completed exists.

5.

[Sample Settings]
Displays settings related to sample acquisition.
[Sample Group]
Selects the sample group to which the sample belongs.
[Auto acquisition target]
Place a check mark in the checkbox to set as the auto acquisition target.

6.

Wells
Displays the status of each well using icons.

: Data recording has completed.
: Data has not been acquired yet.

The icon varies depending on the worksheet mode.
: [Shared] mode
: [Individual] mode

7.

[Close]
Closes the dialog.

8.
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Plate Properties Dialog

The plate properties dialog is used to edit plate information and configure settings for data acquisition.
The plate properties dialog is displayed by clicking  of [Plate] on the [Analysis] tab of the ribbon, or right-clicking a
plate in the experiment list and selecting [Properties].

[Plate Information]
Allows you to edit information related to the plate.
[Type]
Displays the type of plate.
[Name]
Enter the name of the plate.
[Date Created]
Displays the date created.
[Number (optional)]
Enter a plate number, as required.
[Memo (optional)]
Enter a comment, as required.

1.

[Acquisition settings]
Configures settings for data acquisition.
[Order]

2.
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Select the well acquisition sequence.
[OK]
Saves the settings and closes the dialog.

3.

[Cancel]
Cancels the settings and closes the dialog.

4.
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Sample Group Properties Dialog

The sample group properties dialog is used to configure metadata for a sample group.
The sample properties dialog is displayed by clicking  of [Sample Group] on the [Analysis] tab of the ribbon, or right-
clicking a sample group in the experiment list and selecting [Properties].

[Sample Group Information]
You can edit information about a sample group.
[Name]
Enter the name of the sample group.
[Date Created]
Displays the date created.
[Memo (optional)]
Enter a comment, as required.

1.

[Sample Group Settings]
Displays settings for a sample group.
[Sample Group Type]
Displays the sample group type. This parameter cannot be modified.

2.

[OK]
Saves the settings and closes the dialog.

3.

[Cancel]4.
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Cancels the settings and closes the dialog.
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Well Properties Dialog

The well properties dialog is used to edit the sample information, add keywords to the sample, and check the sample
status.
The well properties dialog is displayed by clicking  of [Sample] on the [Analysis] tab of the ribbon, or right-clicking a
well in the [Plate] panel and selecting [Properties].

[Sample Information]
You can edit information about a sample.
[Name]
Enter the name of the well.
[Cell (optional)]
Enter information about the cell, as required.
[Condition (optional)]

1.
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Enter the condition of the sample, as required.
[Memo (optional)]
Enter a comment, as required.
[Sample Keywords]
You can edit the sample keywords for the keyword names set in an experiment.
[Name]
Displays the keyword names configured in the experiment.
[Value]
Enter a sample keyword.

2.

[Sample Status]
Displays the acquisition status of the sample.
[Status]
Displays the acquisition status of the sample.
[Acquisition Date]
Displays the acquisition date and time.
[Acquisition Condition]
Displays the acquisition end condition.

[Normal]: Acquisition ended successfully.
[Low Event Rate]: A low event rate or reducing event rate was detected.
[Air]: Air bubbles have been detected.
[Elapsed Time Limit]: The upper limit of acquisition time has been reached.

[Total Events]
Displays the number of events.
[Aborted Events]
Displays the number of aborted events and their percentage.
[Worksheet Mode]
Displays the worksheet sharing mode.
[Unmixing Cache]
Displays whether data for which fluorescence unmixing calculation has completed exists.

3.

[Sample Settings]
Displays settings related to sample acquisition.
[Sample Group]
Selects the sample group to which the sample belongs.
[Auto acquisition target]
Place a check mark in the checkbox when automatically acquired well.

4.

[OK]
Saves the settings and closes the dialog.

5.

[Cancel]
Cancels the settings and closes the dialog.

6.

254



Help Guide

SFA - Life Sciences Cloud Platform

[Instrument Settings] Dialog

The [Instrument Settings] dialog is used to view the instrument settings of the sample group.
The [Instrument Settings] dialog is displayed by selecting a sample group in the experiment list and then clicking
[Instrument Settings] of [Sample] on the [Analysis] tab of the ribbon.

[Laser] tab

The [Laser] tab displays the lasers used in acquisition and the laser output.

[Laser On/Off]
Displays the on/off status of the lasers used in acquisition.
[Laser Power]
Displays the laser output of each laser.

[Detector & Threshold] tab

The [Detector & Threshold] tab displays settings related to detectors and thresholds.
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[FSC Gain]
Displays the forward scatter (FSC) gain level.
[SSC Voltage (%)] ([SSC Voltage (ST)] in Standardization mode)
Displays the side scatter (SSC) PMT voltages.
[PMT Voltage (%)] ([PMT Voltage (ST)] in Standardization mode)
Displays the PMT voltage of each laser channel.
[Threshold]
Displays the channel for the threshold to trigger detection of events.
[Windows Extensions]
Displays the window extension setting.
The relationship between the window extension and particle size is as follows.

Narrow: Up to 3 µm
Normal: Up to 10 µm
Wide: Up to 20 µm
Extra Wide: Up to 40 µm

[Flow Control] tab

Displays settings related to the instrument.
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[Boost]
Displays the boost time.
[Sample Flow Rate]
Displays the sample flow rate.
[Acquisition Offset Time]
Displays the time to offset the start of data acquisition for each well.

[Agitation] tab

Displays settings related to agitation.

[Low Dead Volume]
Displays whether [Low Dead Volume] mode is enabled or disabled.
[Agitation]
Displays whether the agitation function is enabled or disabled.
[Pattern]
Displays the agitation method.

[Once]: Agitate only once before sample acquisition.
[Cyclic]: Agitate repeatedly at regular intervals during sample acquisition.
[Continuous]: Agitate continuously during sample acquisition.

[Mode]
Displays the agitation mode.

[Normal]: Agitate normally.
[Short]: Agitate gently.
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[Event Check] tab

Displays settings related event rate drop and bubble detection.

[Event Check]
Displays the setting for whether to detect event rate drops and air bubbles.
[Auto Acquire Preferences]
Displays the setting for whether automatic acquisition stops or continues if the event rate drops or air bubbles are
detected during automatic acquisition.

[Stop]: Stops automatic acquisition when the event rate drops or air bubbles are detected.
[Continue]: When the event rate drops or air bubbles are detected, cleaning is performed and automatic acquisition
continues from the next sample.

[Cleaning] tab

Displays settings related to cleaning the sample probe.

[Cleaning Mode]
Displays the cleaning method used between acquisition of each well.

[Inner and Outer]: Cleans the interior and exterior of the sample probe by backflushing with sheath fluid.
[Inner Only]: Cleans the interior of the sample probe only by backflushing with sheath fluid.
[No Wash]: Skips sample probe cleaning.

[Detector (Advanced)] tab

Displays the voltage for each detector channel.
This tab can be displayed only when the instrument setting mode is [Normal Mode] and the [Advanced Settings] items
have been set.
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[Unmixing Settings] Dialog ([Color Panel] Tab)

The [Color Panel] tab of the [Unmixing Settings] dialog is used to perform tasks such as editing the fluorochrome list and
creating spectral references.
The [Unmixing Settings] dialog is displayed by clicking [Unmixing Settings] of [Unmixing] on the [Unmixing] tab of the
ribbon.

Fluorochrome list

For details about the operation, see “Creating a Spectral Reference.”

1.

[Add]
Adds a fluorochrome to the fluorochrome list.

2.
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[Universal Negative]
Assigning a gate to universal negative and then setting the negative of each fluorochrome to universal negative
eliminates the need for individual negative gate settings.

3.

[Ex. Laser]
Specify a laser to filter the fluorochromes displayed in the list.

4.

[Spectral Reference]
Displays a magnified view of the waveforms for the spectral reference selected in the fluorochrome list.

5.

[Fluorochrome Settings]

[Load from Library]: Loads a spectral reference from the library. Selecting this menu item displays the [Load
Spectral Reference] dialog. See “[Load Spectral Reference] Dialog”.
[Add to Library]: Registers the spectral references with check marks in the fluorochrome list to the library.

6.

[Color Panel Settings]
Displays the following menu items.

[Import]: Imports saved fluorochrome list data.
[Export]: Exports fluorochrome list data as a CSV file.

7.

[Autofluorescence]
Use to edit the autofluorescence list.

[Add]: Adds an autofluorescence color to the autofluorescence list.

8.

[Autofluorescence]

[Import]: Imports the autofluorescence spectral reference data from a file.
[Export]: Exports the autofluorescence spectral reference data to a file.

9.

[Calculate]
Calculates the fluorescence unmixing matrix.

10.

[Apply]
Selects whether fluorescence unmixing is applied to plots on the worksheet.

11.

[Close]
Closes the dialog.

12.
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[Unmixing Settings] Dialog ([Matrix] Tab)

The [Matrix] tab of the [Unmixing Settings] dialog is used to edit the fluorescence unmixing matrix.

[Matrix] list
Displays a list of registered matrices. You can also rename matrices, as required.
[Selected Matrix]
Selects a matrix.
[Name]
Enter the name of the matrix.

1.

Editing buttons
[New]
Adds a matrix to the [Matrix] list.

2.
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[Duplicate]
Duplicates the selected matrix in the [Matrix] list.
[Delete]
Deletes the matrix selected in the [Matrix] list.
[Import]
Imports a matrix saved to a file in CSV format.
[Export]
Exports the matrix selected in the [Matrix] list to a file in CSV format. The spectral references, spectral unmixing
matrix, and other information are saved in the CSV file.
[Close]
Closes the dialog.

3.
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[Load Spectral Reference] Dialog

The [Load Spectral Reference] dialog is used to load the spectral reference from the spectral reference library.
The [Load Spectral Reference] dialog is displayed by clicking [Load Spectral Reference] of [Spectral Reference] on the
[Unmixing] tab of the ribbon.

Search area
Specify keywords and filter criteria to search for a spectral reference.
[Keyword Search]
Searches by keyword. Enter a fluorochrome name or marker, then click [Search] to start searching.
[Filters]
Expand each item and place check marks in the search condition check boxes.

Hint

Clicking [Clear] removes the check marks from all checkboxes.

1.

[Search Results]
Displays the search results.
Select the spectral reference to load from the list.
[Select]
Adds the spectral reference selected in [Search Results] to [Selected Spectral References].

2.

[Selected Spectral References]3.
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Lists the spectral references to load. Selecting a spectral reference displays the spectral waveform on the right side
of the list. Multiple selections are supported.
[Remove]
Removes the selected spectral reference from the list.
[Load]
Loads the spectral references in [Selected Spectral References] into the experiment.

4.

[Cancel]
Cancels the operation and closes the dialog.

5.
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[Fluorochrome Database] Dialog

The [Fluorochrome Database] dialog is used to edit the fluorochrome database.
The [Fluorochrome Database] dialog is displayed by clicking [Fluorochrome Database] of [Fluorochrome] on the
[Unmixing] tab of the ribbon.

Fluorochrome list
Displays the available fluorochromes.

1.

[New]
Registers a new fluorochrome. Clicking this button displays the [Add New Fluorochrome] dialog.

For details about the [Add New Fluorochrome] dialog, see “Adding a New Fluorochrome”.

2.

[Delete]
Deletes the fluorochrome selected in the fluorochrome list.

3.

[Fluorochrome Information]
Displays information about the fluorochrome selected in the fluorochrome list.

4.
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[Close]
Closes the dialog.

5.
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[Statistics Editor] Dialog

The [Statistics Editor] dialog is used to add statistics to the statistics table.
The [Statistics Editor] dialog is displayed by clicking [Edit] of [Statistics] on the [Worksheet Tools] tab of the ribbon.

For details about the operation, see “Customizing the Statistics Table.”

Gate list
Displays the hierarchy of gates added to the displayed sample tube. The top level in the hierarchy is represented by
[All Events] (ungated parent population).

1.

Statistics list
Displays the statistics values for the selected gate in the gate list. Place check marks in the checkboxes for the
statistics you want to add to the statistics table.
You can select the following statistics.

2.
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[Mean]: Mean value in the gated population. The mean value can also be used as a guide when adjusting the
fluorescence unmixing spillover matrix manually.
[Min.]: Minimum value in the gated population.
[Max.]: Maximum value in the gated population.
[SD]: Standard deviation of events from the mean value of the gated population.
[CV]: Coefficient of variation of the distribution in the gated population.
[Median]: Median value in the gated population. The median value can also be used as a guide when adjusting
the fluorescence unmixing spillover matrix manually if there are a large number of outlying events (rare points).
[Mode]: Mode value in the gated population. Corresponds to the highest peak on a histogram plot.

[Delete]
Deletes the pulse parameter selected in the statistics list.

3.

[Add]
Adds pulse parameters to the statistics list. A new parameter configuration item is added to the bottom with each
click. Select [Parameter] and [Type], and select the parameters to display.

4.

[Close]
Closes the dialog.

5.
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[Gate Manager] Dialog

The [Gate Manager] dialog is used to manage and configure the gates set for the selected sample tube.
The [Gate Manager] dialog is displayed by clicking [Gate Manager] in [Gates] on the [Worksheet Tools] tab or in [Edit] on
the [Gate Tools] tab.

Gate list
Displays a list of gates added to the selected sample tube.
The following information is displayed for each gate.

[Name]: Displays the name of the gate.
[Equation]: Displays the equation of the gate.
[Paint]: Place check marks in the checkboxes of the gates for which to add colors on dot plots and histogram
plots.

1.
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[Axes]: Displays the X and Y axes of the plot.

[Check all manual gates]
Places check marks in the checkboxes of all manually set gates.
[Uncheck all manual gates]
Clears the check marks from the checkboxes of all manually set gates.
[Check all meta cluster gates]
Places check marks in the checkboxes of all meta cluster gates.
[Uncheck all meta cluster gates]
Clears the check marks from the checkboxes of all metal cluster gates.
[Show Paint Gate Name]
Displays the names of gates with check marks in [Paint] on dot plots and histogram plots.
Change order
Changes the order of the gate selected in the list. The order is used to change the coloring of events for each gate on
dot plots.
[Move to top]
Moves the gate to the top.
[Move up]
Moves the gate up one row each time the button is clicked.
[Move down]
Moves the gate down one row each time the button is clicked.
[Move to bottom]
Moves the gate to the bottom.

2.

[Remove]
Removes the gate selected in the list.

3.

[Gate Properties]
Displays information about the gate selected in the list.
[Name]
Displays the name of the gate. You can edit the information, as required.
[Statistics]
Displays the statistics parameter configured for the gate. You can edit the information, as required.

[Total%]: Proportion of events in the gated population as a percentage of the total number of events ([All Events]).
[Parent%]: Proportion of events in the gated population as a percentage of the number of events in the parent
population.
[Events]: Number of events in the gated population.

[Color]
Displays the color of the gate. You can edit the information, as required.
[Parent Gate]
Displays the parent gate.
[Equation]
Displays the equation of the gate.
[Expanded Equation]
Displays the equation in the format (Parent gate) AND Equation. Note that this item is omitted if the parent gate is “All
Events.”

4.

[Close]
Closes the dialog.

5.
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[Gate Properties] Dialog

The [Gate Properties] dialog displays information about the selected plot. You can change the setting of each parameter,
as required.
The [Gate Properties] dialog is displayed by clicking  of [Edit] on the [Gate Tools] tab of the ribbon or right-clicking a
gate and selecting [Properties].

[Name]
Displays the name of the gate.
Place a check mark in [Show on the chart] to display the name of the gate on the plot.
[Statistics]
Selects the statistics parameter configured for the gate.
Place a check mark in [Show on the chart] to display the statistics parameter on the plot.

[Total%]: Proportion of events in the gated population as a percentage of the total number of events ([All Events]).
[Parent%]: Proportion of events in the gated population as a percentage of the number of events in the parent
population.
[Events]: Number of events in the gated population.

[Color]
Selects the color of the gate.
[Parent Gate]
Displays the parent gate.
[Equation]
Displays the equation of the gate. This parameter cannot be modified.
[Expanded Equation]
Displays the equation in the format (Parent gate) AND Equation. Note that this item is omitted if the parent gate is “All
Events.” This parameter cannot be modified.
[Close]
Closes the dialog.
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[Plot Properties] Dialog (Properties for Dot Plots, Density Plots, and Histogram Plots)

The [Plot Properties] dialog displays information about the selected plot. You can change the setting of each parameter,
as required.
The [Plot Properties] dialog is displayed by clicking  of [Edit] or right-clicking a plot and selecting [Properties].

Basic information
Displays the following information. You can change the settings, as required.
[Title]
Title of the plot.
[Source]
Population of the plot (parent gate).
[Plot Type]
Type of plot.

1.

[X Axis]
Displays information about the X axis of the plot. You can change the settings, as required.
[Parameter]
Parameter.

2.
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[Axis Type]
Type of axis.

Linear: Performs a linear transformation between the acquisition values and the channel numbers (bins) used to
acquire data (0 to 256). Linear scales are typically used to display forward scatter and back scatter parameters
on plots.
Log: Display cells that exhibit fluorescence with intensities across a wide dynamic range. Log scales help to make
individual peaks easier to visualize. However, log scales cannot adequately represent data with a low mean and
high variance.
Bi-exponential: Combination of a linear scale at the lower end of the axis (around zero) and a logarithmic scale at
the higher end of the axis, with an algorithmic transition between the two scales. A biexponential scale allows
events close to or below zero to be plotted.

[Minimum]
Minimum value of the scale.
[Maximum]
Maximum value of the scale.
[Label]
Axis label displayed on the graph.
[Axis Settings]
Clicking [Save as Preference Settings] saves the current state as preference settings.
[Y Axis]
Displays information about the Y axis of the plot.
For details about each item, see [X Axis].

3.

[Close]
Closes the dialog.

4.
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[Plot Properties] Dialog (Properties for Contour Plots)

The [Plot Properties] dialog displays information about the selected plot. You can change the setting of each parameter,
as required.
The [Plot Properties] dialog is displayed by clicking  of [Edit] or right-clicking a plot and selecting [Properties].

Basic information
Displays the following information. You can change the settings, as required.
[Title]
Title of the plot.
[Source]
Population of the plot (parent gate).
[Plot Type]
Type of plot.
[Method]
Division method.

1.
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[Probability]: Draw contour lines so that each area between contour lines contains the same number of events.
[Linear]: Draw contour lines so that each area between contour lines contains the maximum density divided
linearly.
[Log]: Draw contour lines so that each area between contour lines contains the maximum density divided
logarithmically.

[Percentage]
Percentage division of the contour lines. The larger the number, the larger the distance between contour lines.
[Color Scheme]
Contour colors.

[Multicolor]: High-density contour lines are shown in red, and low-density contour lines are shown in blue.
[Black/White]: Display in black and white.

[Show Outliers]
Place a check mark here to display outlier events outside the outermost contour lines as dots.
[X Axis]
Displays information about the X axis of the plot. You can change the settings, as required.
[Parameter]
Parameter.
[Axis Type]
Type of axis.

Linear: Performs a linear transformation between the acquisition values and the channel numbers (bins) used to
acquire data (0 to 256). Linear scales are typically used to display forward scatter and back scatter parameters
on plots.
Log: Display cells that exhibit fluorescence with intensities across a wide dynamic range. Log scales help to make
individual peaks easier to visualize. However, log scales cannot adequately represent data with a low mean and
high variance.
Bi-exponential: Combination of a linear scale at the lower end of the axis (around zero) and a logarithmic scale at
the higher end of the axis, with an algorithmic transition between the two scales. A biexponential scale allows
events close to or below zero to be plotted.

[Minimum]
Minimum value of the scale.
[Maximum]
Maximum value of the scale.
[Label]
Axis label displayed on the graph.
[Axis Settings]
Clicking [Save as Preference Settings] saves the current state as preference settings.

2.

[Y Axis]
Displays information about the Y axis of the plot.
For details about each item, see [X Axis].

3.

[Close]
Closes the dialog.

4.
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[Plot Properties] Dialog (Properties for Color Axis Plots)

The [Plot Properties] dialog displays information about the selected plot. You can change the setting of each parameter,
as required.
The [Plot Properties] dialog is displayed by clicking  of [Edit] or right-clicking a plot and selecting [Properties].

Basic information
Displays the following information. You can change the settings, as required.
[Title]
Title of the plot.
[Source]
Population of the plot (parent gate).
[Plot Type]
Type of plot.
[Parameter]
Parameter.
[Label]
Axis label displayed on the graph.

1.
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[X Axis]
Displays information about the X axis of the plot. You can change the settings, as required.
[Parameter]
Parameter.
[Axis Type]
Type of axis.

Linear: Performs a linear transformation between the acquisition values and the channel numbers (bins) used to
acquire data (0 to 256). Linear scales are typically used to display forward scatter and back scatter parameters
on plots.
Log: Display cells that exhibit fluorescence with intensities across a wide dynamic range. Log scales help to make
individual peaks easier to visualize. However, log scales cannot adequately represent data with a low mean and
high variance.
Bi-exponential: Combination of a linear scale at the lower end of the axis (around zero) and a logarithmic scale at
the higher end of the axis, with an algorithmic transition between the two scales. A biexponential scale allows
events close to or below zero to be plotted.

[Minimum]
Minimum value of the scale.
[Maximum]
Maximum value of the scale.
[Label]
Axis label displayed on the graph.
[Options]

[Negative Area]: Sets negative area.
[Extra Negative Area]: Sets extra negative area.

[Axis Settings]
Clicking [Save as Preference Settings] saves the current state as preference settings.

2.

[Y Axis]
Displays information about the Y axis of the plot.
For details about each item, see [X Axis].

3.

[Close]
Closes the dialog.

4.
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[Plot Properties] Dialog (Properties for Spectrum Plots)

The [Plot Properties] dialog displays information about the selected plot. You can change the setting of each parameter,
as required.
The [Plot Properties] dialog is displayed by clicking  of [Edit] or right-clicking a plot and selecting [Properties].

Basic information
Displays the following information. You can change some of the items, as required.
[Title]
Title of the plot.
[Source]
Population of the plot (parent gate).
[Plot Type]
Type of plot. This parameter cannot be modified.

1.

[X Axis]
Displays information about the X axis of the plot. You can change some of the items, as required.
[Parameter]
Parameter. This parameter cannot be modified.

2.
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[Axis Type]
Type of axis. This parameter cannot be modified.
[Minimum]
Minimum value of the scale. This parameter cannot be modified.
[Maximum]
Maximum value of the scale. This parameter cannot be modified.
[Label]
Axis label displayed on the graph.
[Axis Settings]
[Save as Preference Settings] is disabled.
[Y Axis]
Displays information about the Y axis of the plot. You can change some of the items, as required.
[Parameter]
Parameter.
[Axis Type]
Type of axis.

Linear: Performs a linear transformation between the acquisition values and the channel numbers (bins) used to
acquire data (0 to 256). Linear scales are typically used to display forward scatter and back scatter parameters
on plots.
Log: Display cells that exhibit fluorescence with intensities across a wide dynamic range. Log scales help to make
individual peaks easier to visualize. However, log scales cannot adequately represent data with a low mean and
high variance.
Bi-exponential: Combination of a linear scale at the lower end of the axis (around zero) and a logarithmic scale at
the higher end of the axis, with an algorithmic transition between the two scales. A biexponential scale allows
events close to or below zero to be plotted.

[Minimum]
Minimum value of the scale.
[Maximum]
Maximum value of the scale.
[Label]
Axis label displayed on the graph.
[Options]

[Negative Area]: Sets negative area.
[Extra Negative Area]: Sets extra negative area.

[Axis Settings]
[Save as Preference Settings] is disabled.

Hint
The range that can be specified using scale minimum and maximum values depends on the parameter. [Wavelength] and
[Channel] minimum and maximum values are fixed.

3.

[Close]
Closes the dialog.

4.
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[Data Cleaning] Dialog

The [Data Cleaning] dialog is used to set the conditions for removing noise and outliers.
The [Data Cleaning] dialog is displayed by selecting [Data Cleaning] of [Data Quality] on the [Gate Tools] tab of the
ribbon.

[Fluorochromes] List
Selects the fluorochromes to use as inputs.

1.

[Perform Auto Adjust (Biexponential) as pre-process]
Place a check mark in this checkbox to run auto adjust (biexponential) as a pre-process for those fluorochromes
selected as inputs which do not have a plot on the worksheet.

2.

[Data Cleaning]
Specifies the algorithm to use. You can select the following algorithms.

[flowAI]
[PeacoQC]
[flowCut]
[flowClean]

3.

[OK]4.
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Runs data cleaning.
Running data cleaning generates a new gate. The generated gate includes only events determined to be of good
quality by the algorithm.
[Cancel]
Cancels the settings and closes the dialog.

5.
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[BL-FlowSOM] Dialog

The [BL-FlowSOM] dialog is used to set the learning conditions for analysis using the BL-FlowSOM function.
The [BL-FlowSOM] dialog is displayed by selecting [BL-FlowSOM] of [Clustering] on the [Gate Tools] tab of the ribbon.

[Concatenate Other Samples]
Displays the [Sample Selection] dialog to concatenate multiple samples for learning. The number of samples to be
concatenated is displayed on the right side of the button. For details about the operation, see “Analyzing by
Concatenating Multiple Samples (when BL-FlowSOM).”

1.

[Fluorochromes] List
Selects the fluorochromes to use as inputs.

2.

[Perform Auto Adjust (Biexponential) as pre-process]
Place a check mark in this checkbox to run auto adjust (biexponential) as a pre-process for those fluorochromes
selected as inputs which do not have a plot on the worksheet.

3.

[Use existing SOM]
Place a check mark when creating an MST plot using the existing SOM. If the existing SOM are used, the learned
SOM are used to create the MST.

4.
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Learning Parameters
[SOM Grid Size]
Sets the size of one side of the SOM.
In the case of “10”, for example, one side 10 x 10 = 100.
[Number of Meta Clusters]
Sets the number of meta clusters.

[Auto (Max Number)]: Determines the number of meta clusters automatically with the specified number of meta
clusters as the upper limit.
[Fixed]: Generates the input number of meta clusters.

[Number of Iterations]
Specifies the number of times to repeat learning.

5.

[OK]
Saves the settings and closes the dialog.

6.

[Cancel]
Cancels the settings and closes the dialog.

7.
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[UMAP] Dialog

The [UMAP] dialog is used to set the learning conditions for analysis using UMAP of the dimensionality reduction
function.
The [UMAP] dialog is displayed by selecting [UMAP] of [Dimensionality Reduction] on the [Gate Tools] tab of the ribbon.

[Concatenate Other Samples]
Displays the [Sample Selection] dialog to concatenate multiple samples for learning. The number of samples to be
concatenated is displayed on the right side of the button. For details about the operation, see “Analyzing by
Concatenating Multiple Samples (when UMAP and FIt-SNE).”

1.

[Fluorochromes] List
Selects the fluorochromes to use as inputs.

2.

[Perform Auto Adjust (Biexponential) as pre-process]
Place a check mark in this checkbox to run auto adjust (biexponential) as a pre-process for those fluorochromes
selected as inputs which do not have a plot on the worksheet.

3.
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Learning Parameters
[Nearest Neighbors]
Sets up to what is the nearest event to be a calculation target.
[Minimum Distance]
Specifies the minimum distance after dimensional compression.
[Number of Components]
Specifies the number of dimensions (2 or 3) after dimensional compression.
[Metric]
Selects the calculation method for the distance.

[Euclidean]
[Manhattan]
[Cosine]
[Hamming]

4.

[OK]
Saves the settings and closes the dialog.

5.

[Cancel]
Cancels the settings and closes the dialog.

6.

287



Help Guide

SFA - Life Sciences Cloud Platform

[FIt-SNE] Dialog

The [FIt-SNE] dialog is used to set the learning conditions for analysis using FIt-SNE of the dimensionality reduction
function.
The [FIt-SNE] dialog is displayed by selecting [FIt-SNE] of [Dimensionality Reduction] on the [Gate Tools] tab of the
ribbon.

[Concatenate Other Samples]
Displays the [Sample Selection] dialog to concatenate multiple samples for learning. The number of samples to be
concatenated is displayed on the right side of the button. For details about the operation, see “Analyzing by
Concatenating Multiple Samples (when UMAP and FIt-SNE).”

1.

[Fluorochromes] List
Selects the fluorochromes to use as inputs.

2.

[Perform Auto Adjust (Biexponential) as pre-process]3.
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Place a check mark in this checkbox to run auto adjust (biexponential) as a pre-process for those fluorochromes
selected as inputs which do not have a plot on the worksheet.
Learning Parameters
[Iterations]
Specifies the number of times to repeat learning.
[Perplexity]
The perplexity parameter determines the width of the Gaussian kernel.
[Learning Configuration]
Selects whether to set the learning configuration to automatic or manual. If [Manual] is selected, specify the learning
rate in [Learning Rate].
[Learning Rate]
Specifies the learning rate.
[KNN Algorithm]
Specifies the k-nearest neighbors algorithm to be used.
[Gradient Algorithm]
Specifies the approximation algorithm to be used in gradient descent.

4.

[OK]
Saves the settings and closes the dialog.

5.

[Cancel]
Cancels the settings and closes the dialog.

6.
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[Library] Tab

The [Library] tab is used to edit spectral references.
The [Library] tab has the following structure.
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[Library] Tab (Ribbon)
The [Library] tab of the ribbon has the following buttons.
[Import]
Imports spectral reference data saved in a file.
[Export]
Exports the spectral reference data to a file.

Allows you to view information related to the spectral reference selected in the list.

1.

[Filters] pane
Filters the search for a spectral reference.
The search results for filters with a check mark are displayed in [Search Results].

2.

[Search Results]
Displays the spectral reference search results in list view.
You can filter by lasers using the drop-down menu at the top right.
You can check the waveform in the area on the right by selecting a spectral reference in the list.

3.
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Toolbar

The following tools are available on the top right of the window.

Upper row
/

Shows/hides the ribbon tabs.
[Project]
Switches the project or changes the workspace.

Displays notifications. When there are unread notifications, a red circle mark is added ( ).

For details, see “Viewing Notifications.”

Displays the user account information. Clicking [View Account] displays the [Spectral Flow Analysis Login] window to
enable editing of the account settings.

Logs out from Spectral Flow Analysis.

Displays the help guide of Spectral Flow Analysis.

Lower row
[  Unmixing]
Selects whether spectral unmixing is applied to plots on the worksheet.
This setting is reflected on the unmixing settings.
This function is the same as [Apply] on the [Unmixing] tab of the ribbon.

Allows you to adjust the fluorescence unmixing.
Clicking this button displays the [Unmixing Settings] dialog. See “[Unmixing Settings] Dialog ([Color Panel] Tab)”.
This function is the same as [Unmixing Settings] on the [Unmixing] tab of the ribbon.

Enables manual adjustment of spectral unmixing by adjusting the spectral reference of the selected matrix.
Clicking this button displays the [Spectral Reference Adjuster] dialog.
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This function is the same as [Spectral Reference Adjuster] on the [Unmixing] tab of the ribbon.

For details about the operation, see “Adjusting Spectral Unmixing Manually (Spectrum)”.

You can check the results of spectral unmixing by displaying a list of plots for each fluorochrome combination.
Clicking this button displays the [Unmixing Viewer] dialog.
This function is the same as [Unmixing Viewer]on the [Unmixing] tab of the ribbon.

For details, see “Checking Fluorochrome Unmixing Results Summary”.

Allows you to manually correct the fluorescence unmixing by adjusting the spectral reference of the selected matrix.
Clicking this button displays the [Spectral Reference Adjuster] dialog.
This function is the same as [Spectral Reference Adjuster] on the [Unmixing] tab of the ribbon.

For details about the operation, see “Adjusting Spectral Unmixing Manually (Spectrum)”.

 / 
Zoom in/out the entire worksheet.
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Statistics Table

The statistics table displays the following information.

[Name]
Displays the names of gates and parameters.
[Events]
Displays the number of events.
[Parent%]
Displays the proportion of events of each gate relative to its parent.
[Total%]
Displays the proportion of events of each gate relative to the total of all events.
Gate hierarchy
Displays the hierarchical relationship between gates. The color to the left of the gate name shows the color of the gates
on plots.
You can change the statistics items displayed for each gate in the statistics table.

For details about the operation, see “Editing Items Displayed in the Statistics Table.”
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Status Bar

The status of the Spectral Flow Analysis software is displayed at the bottom right of the worksheet.

[Status]
Displays the connection status.
[Type]
Displays the analysis server type.
[CPU]
Displays the CPU usage percentage.
[Memory]
Displays the memory usage percentage.
[Storage]
Displays the storage usage percentage and free space.
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Experiments

The following menu commands are displayed when right-clicking an experiment icon in the [Experiment] panel.

When the [View] tab is displayed

[Start Analysis]
Opens the [Analysis] tab to analyze the selected experiment.
If another user’s experiment is selected in the project, the experiment is duplicated as your own and it is opened on the
[Analysis] tab.

For details about the operation, see “Opening the [Analysis] Tab.”

[Duplicate Experiment]
Duplicates the selected experiment.
If another user’s experiment is selected in the project, the experiment is duplicated as your own.
[Cancel import jobs]
Cancels importing of experiments.
[Delete]
Deletes the selected experiment.
[Properties]
Displays the properties for the selected experiment.

When the [Analysis] tab is displayed

[Close Experiment]
Closes the experiment.
[Batch Analysis]
Runs analysis on multiple samples at the same time. This function is the same as [Batch Analysis] on the [Analysis] tab
of the ribbon.

For details on the operation, see “Running Batch Analysis.”

[Export to FCS File]
Exports data in FCS format. This function is the same as [Export to FCS File] on the [Analysis] tab of the ribbon.

For details on the operation, see “Exporting an FCS File.”

[Properties]
Displays the properties for the selected experiment.
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Plates

The following menu commands are displayed when right-clicking a plate icon in the [Experiment] panel.

When the [View] tab is displayed

[Properties]
Displays the properties for the selected plate.

[Analysis] Tab

[Close Experiment]
Closes the experiment.
[Export Layout to CSV File]
Exports the metadata of the selected plate to a file in CSV format. This function is the same as [Export Layout to CSV
File] on the [Analysis] tab of the ribbon.
[Import Layout from CSV File]
Imports all metadata to the selected plate. This function is the same as [Import Layout from CSV File] on the [Acquisition]
tab of the ribbon.
[Batch Analysis]
Runs analysis on multiple samples at the same time. This function is the same as [Batch Analysis] on the [Analysis] tab
of the ribbon.

For details on the operation, see “Running Batch Analysis.”

[Export to FCS File]
Exports data in FCS format. This function is the same as [Export to FCS File] on the [Analysis] tab of the ribbon.

For details on the operation, see “Exporting an FCS File.”

[Properties]
Displays the properties for the selected plate.
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Sample Groups

The following menu commands are displayed when right-clicking a sample group icon in the [Experiment] panel.

When the [View] tab is displayed

[Instrument Settings]
Allows you to configure instrument settings related to lasers, detectors, and flow rates. Clicking this button displays the
[Instrument Settings] dialog. This function is the same as [Instrument Settings] on the [Analysis] tab of the ribbon. See
“[Instrument Settings] Dialog”.
[Stopping Condition]
Allows you to view the data acquisition stopping condition. Clicking this button displays the [Stopping Condition] dialog.
This function is the same as [Stopping Condition] on the [Analysis] tab of the ribbon.
[Properties]
Displays the properties for the selected sample group.

When the [Analysis] tab is displayed

[Close Experiment]
Closes the experiment.
[Batch Analysis]
Runs analysis on multiple samples at the same time. This function is the same as [Batch Analysis] on the [Analysis] tab
of the ribbon.

For details on the operation, see “Running Batch Analysis.”

[Export to FCS File]
Exports data in FCS format. This function is the same as [Export to FCS File] on the [Analysis] tab of the ribbon.

For details on the operation, see “Exporting an FCS File.”

[Copy to all Individual Worksheets]
Copies the shared worksheet to the individual worksheet of all samples.
[Copy to Shared Worksheet]
Sets the worksheet for the selected sample as the shared worksheet.
[Instrument Settings]
Allows you to configure instrument settings related to lasers, detectors, and flow rates. Clicking this button displays the
[Instrument Settings] dialog. This function is the same as [Instrument Settings] on the [Analysis] tab of the ribbon. See
“[Instrument Settings] Dialog”.
[Stopping Condition]
Allows you to view the data acquisition stopping condition. Clicking this button displays the [Stopping Condition] dialog.
This function is the same as [Stopping Condition] on the [Analysis] tab of the ribbon.
[Properties]
Displays the properties for the selected sample group.
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Wells

The following menu commands are displayed when right-clicking a well in the [Plate] panel.

When the [View] tab is displayed

[Instrument Settings]
Allows you to configure instrument settings related to lasers, detectors, and flow rates. Clicking this button displays the
[Instrument Settings] dialog. This function is the same as [Instrument Settings] on the [Analysis] tab of the ribbon. See
“[Instrument Settings] Dialog”.
[Stopping Condition]
Allows you to view the data acquisition stopping condition. Clicking this button displays the [Stopping Condition] dialog.
This function is the same as [Stopping Condition] on the [Analysis] tab of the ribbon.
[Properties]
Displays the properties for the selected well.

When the [Analysis] tab is displayed

[Close Experiment]
Closes the experiment.
[Copy]/[Paste]
Copies and pastes the selected well. This function is the same as [Copy]/[Paste] on the [Analysis] tab of the ribbon.
[Export Instrument Settings]
Exports the instrument settings as a file.
[Export to FCS File]
Exports data in FCS format. This function is the same as [Export to FCS File] on the [Analysis] tab of the ribbon.

For details on the operation, see “Exporting an FCS File.”

[Copy to all Individual Worksheets]
Copies the shared worksheet to the individual worksheet of all samples.
[Copy to Shared Worksheet]
Sets the worksheet for the selected sample as the shared worksheet.
[Instrument Settings]
Allows you to configure instrument settings related to lasers, detectors, and flow rates. Clicking this button displays the
[Instrument Settings] dialog. This function is the same as [Instrument Settings] on the [Analysis] tab of the ribbon. See
“[Instrument Settings] Dialog”.
[Stopping Condition]
Allows you to view the data acquisition stopping condition. Clicking this button displays the [Stopping Condition] dialog.
This function is the same as [Stopping Condition] on the [Analysis] tab of the ribbon.
[Properties]
Displays the properties for the selected well.
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Plots

The following menu commands are displayed when right-clicking a plot on the worksheet.

For details about menu commands displayed on an MST plot, see “MST Plots.”

When the [View] tab is displayed

[Copy to Clipboard]
Copies the selected plot to the clipboard so that it can be pasted in other software for use in a report or other content.
[Open Gate Manager]
Displays the [Gate Manager] dialog. This function is the same as [Gate Manager] on the [Worksheet Tools] tab of the
ribbon. See “[Gate Manager] Dialog”.
[Properties]
Displays the properties for the selected sample group.

When the [Analysis] tab is displayed

[Auto Adjustment]
Automatically adjusts the scale of the X axis and Y axis for the selected plot. This function is the same as [Auto
Adjustment (XY)] on the [Plot Tools] tab of the ribbon.
[Zoom]
Changes the magnification of the selected plot. This function is the same as [Zoom] on the [Plot Tools] tab of the ribbon.
[Spectrum Display]
Sets the spectrum display mode. This function is the same as [Spectrum Display] on the [Plot Tools] tab of the ribbon.
[Insert Gate]
Creates a gate in the selected plot. This function is the same as [New Gate] on the [Plot Tools] tab of the ribbon. Select
the gate type from the submenu.
[Plot Type]
Changes the type of the selected plot. This function is the same as [Plot Type] on the [Plot Tools] tab of the ribbon.
Select the plot type from the submenu.
[Duplicate]
Duplicates the selected plot within the worksheet. This function is the same as [Duplicate Plot] on the [Plot Tools] tab of
the ribbon.
[Remove]
Removes the selected plot. This function is the same as [Remove Plot] on the [Plot Tools] tab of the ribbon.
[Send to Overlay]
Displays the spectral data for the selected plot on the overlay worksheet. This function is the same as [Send to Overlay]
on the [Worksheet Tools] tab. For details about the operation, see “Displaying Multiple Spectral Data Overlaid.”
[Sync Scale and Gate]
Synchronizes the scale and gates of all plots within a sample group.
[Copy to Clipboard]
Copies the selected plot to the clipboard so that it can be pasted in other software for use in a report or other content.
[Open Gate Manager]
Displays the [Gate Manager] dialog. This function is the same as [Gate Manager] on the [Worksheet Tools] tab of the
ribbon. See “[Gate Manager] Dialog”.
[Open Statistics Editor]
Displays the [Statistics Editor] dialog. This function is the same as [Edit] on the [Worksheet Tools] tab of the ribbon. See
“[Statistics Editor] Dialog”.
[Properties]
Displays the properties for the selected plot.
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MST Plots

The following menu commands are displayed when right-clicking an MST plot on the worksheet.

For details about menu commands displayed on other plots, see “Plots.”

[Graph Mode]
Selects the graph mode for the MST plot. Select from [Star], [Population Pie], and [Median Marker Value]. This function
is the same as  on the toolbar for the MST plot.
[Operation Mode]
Selects the operation mode. Select from [Cluster Selection], [Meta Cluster Selection], [Marquee Zoom], and [Back
Gating].
[Create a Child Plot]
Adds a child plot for the selected gate. This function is the same as [New Child Plot] on the [Gate Tools] tab of the ribbon.
[Show Meta]
Displays the meta clusters.
[Constant Size]
Displays the circles of meta clusters at a constant size. The circle size can be changed in the properties of the MST plot.
[Merge to existing Meta Cluster]
Merges the selected meta cluster with another meta cluster.
[Create new Meta Cluster]
Creates a new meta cluster.
[Revert to original Meta Cluster]
Reverts to the original meta cluster.
[Show Heatmap]
Displays the heatmap.
[Show Star Chart Legend]
Selects the markers to display when star chart.
[Show Meta Cluster Star Chart]
Displays a start chart on a meta cluster basis when star chart.
[Reset]
Returns to the state immediately before the operation was executed.
[Copy to Clipboard]
Copies the selected plot to the clipboard so that it can be pasted in other software for use in a report or other content.
[Properties]
Displays the properties for the selected plot.
[Remove]
Removes the MST plot. When the MST plot is removed, the clustering results are also removed.
This menu command is displayed when right-clicking the frame part of an MST plot.
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Gates

The following menu commands are displayed when right-clicking a gate on the plot.

When the [View] tab is displayed

[Remove]
Removes the selected gate. This function is the same as [Remove Gate] on the [Gate Tools] tab of the ribbon.
[Properties]
Displays the properties for the selected gate.

When the [Analysis] tab is displayed

[Create a Child Plot]
Adds a child plot for the selected gate. This function is the same as [New Child Plot] on the [Gate Tools] tab of the ribbon.
[Assign Gate]
Assigns the selected gate as the following gate types.

Positive Gate
Negative Gate
Universal Negative Gate

[Auto Adjustment (Biexponential)]
Automatically adjusts the scale of the X axis and Y axis for the selected plot. This function is the same as [Auto
Adjustment (XY)] on the [Plot Tools] tab of the ribbon.
[Remove]
Removes the selected gate. This function is the same as [Remove Gate] on the [Gate Tools] tab of the ribbon.
[BL-FloｗSOM]
Displays the [BL-FlowSOM] dialog. This function is the same as [BL-FlowSOM] on the [Gate Tools] tab of the ribbon. See
“[BL-FlowSOM] Dialog”.
[Dimensionality Reduction]
Selects the following dimensionality reduction methods.

[UMAP]: Displays the [UMAP] dialog. This function is the same as [UMAP] on the [Gate Tools] tab of the ribbon. See
“[UMAP] Dialog”.
[FIt-SNE]: Displays the [FIt-SNE] dialog. This function is the same as [FIt-SNE] on the [Gate Tools] tab of the ribbon.
See “[FIt-SNE] Dialog”.

[Properties]
Displays the properties for the selected plot.
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Statistics Table

The following menu commands are displayed when right-clicking the statistics table on the worksheet.

Statistics table frame

[Hide Table]
Hides the statistics table. To redisplay the statistics table, right-click blank space on the worksheet and select [Show
Table] from the context menu.
[Open Gate Manager]
Displays the [Gate Manager] dialog. This function is the same as [Gate Manager] on the [Worksheet Tools] tab of the
ribbon. See “[Gate Manager] Dialog”.
[Open Statistics Editor]
Displays the [Statistics Editor] dialog. This function is the same as [Edit] on the [Worksheet Tools] tab of the ribbon. See
“[Statistics Editor] Dialog”.
[Export Statistics]
Exports the contents of the statistics table as a file in CSV format. This function is the same as [Export Statistics] on the
[Worksheet Tools] tab of the ribbon.

Statistics table cells

[Create a Plot]
Creates a new plot for the selected gate.
[Assign Gate]
Assigns the selected gate as the following gate types.

Positive Gate
Negative Gate
Universal Negative Gate

[Auto Adjustment (Biexponential)]
Automatically adjusts the scale of the X axis and Y axis for the selected plot. This function is the same as [Auto
Adjustment (XY)] on the [Plot Tools] tab of the ribbon.
[Copy]/[Paste]
Copies and pastes the selected gate to duplicate a gate.
[Cut]/[Paste]
Cuts and pastes the selected gate to move it.
[Remove]
Removes the selected gate or statistic (multiple selection supported).
[Export Statistics]
Exports the contents of the statistics table as a file in CSV format. This function is the same as [Export Statistics] on the
[Worksheet Tools] tab of the ribbon.
[Open Gate Manager]
Displays the [Gate Manager] dialog. This function is the same as [Gate Manager] on the [Worksheet Tools] tab of the
ribbon. See “[Gate Manager] Dialog”.
[Open Statistics Editor]
Displays the [Statistics Editor] dialog. This function is the same as [Edit] on the [Worksheet Tools] tab of the ribbon. See
“[Statistics Editor] Dialog”.
[BL-FloｗSOM]
Displays the [BL-FlowSOM] dialog. This function is the same as [BL-FlowSOM] on the [Gate Tools] tab of the ribbon. See
“[BL-FlowSOM] Dialog”.
[Dimensionality Reduction]
Selects the following dimensionality reduction methods.
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[UMAP]: Displays the [UMAP] dialog. This function is the same as [UMAP] on the [Gate Tools] tab of the ribbon. See
“[UMAP] Dialog”.
[FIt-SNE]: Displays the [FIt-SNE] dialog. This function is the same as [FIt-SNE] on the [Gate Tools] tab of the ribbon.
See “[FIt-SNE] Dialog”.

[Properties]
Displays the properties for the selected statistics table.
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Worksheet

The following menu commands are displayed when right-clicking a blank space on the worksheet.

When the [View] tab is displayed

[Close Worksheet]
Closes the worksheet.
[Show Table]
Shows/hides the statistics table. This function is the same as [Show Table] on the [Worksheet Tools] tab.
[Auto Arrange Items]
Automatically aligns the positions of the plots and statistics table. This function is the same as [Auto Arrange] on the
[Worksheet Tools] tab.
[Align Items to Grid]
Aligns the plots and statistics table on the worksheet with the grid.
[Show Grid]
Displays a grid on the worksheet. This function is the same as [Show Grid] on the [Worksheet Tools] tab.
[Open Gate Manager]
Displays the [Gate Manager] dialog. This function is the same as [Gate Manager] on the [Worksheet Tools] tab of the
ribbon. See “[Gate Manager] Dialog”.
[Open Statistics Editor]
Displays the [Statistics Editor] dialog. This function is the same as [Edit] on the [Worksheet Tools] tab of the ribbon. See
“[Statistics Editor] Dialog”.
[Copy to all Individual Worksheets]
Copies the shared worksheet to the individual worksheet of all samples.
[Copy to Shared Worksheet]
Sets the worksheet for the selected sample as the shared worksheet.

When the [Analysis] tab is displayed

[Terminate Analysis]
Terminates the analysis server when it is running.
[Restart Analysis]
Restarts the analysis server.
[Show Table]
Shows/hides the statistics table. This function is the same as [Show Table] on the [Worksheet Tools] tab.
[Auto Arrange Items]
Automatically aligns the positions of the plots and statistics table. This function is the same as [Auto Arrange] on the
[Worksheet Tools] tab.
[Align Items to Grid]
Aligns the plots and statistics table on the worksheet with the grid.
[Show Grid]
Displays a grid on the worksheet. This function is the same as [Show Grid] on the [Worksheet Tools] tab.
[Open Gate Manager]
Displays the [Gate Manager] dialog. This function is the same as [Gate Manager] on the [Worksheet Tools] tab of the
ribbon. See “[Gate Manager] Dialog”.
[Open Statistics Editor]
Displays the [Statistics Editor] dialog. This function is the same as [Edit] on the [Worksheet Tools] tab of the ribbon. See
“[Statistics Editor] Dialog”.
[Copy to all Individual Worksheets]
Copies the shared worksheet to the individual worksheet of all samples.
[Copy to Shared Worksheet]
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Sets the worksheet for the selected sample as the shared worksheet.
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[Color Panel] Tab in the [Unmixing Settings] Dialog

The following menu commands are displayed when right-clicking a fluorochrome in the fluorochrome list.
[Open Positive Sample]
Displays the sample worksheet for the gate configured as the positive gate.
[Open Negative Sample]
Displays the sample worksheet for the gate configured as the negative gate.
[Clear Gates]
Clears the gate assignments for the selected fluorochrome.
[Clear Spectral Reference]
Clears the spectral reference for the selected fluorochrome.
[Edit Fluorochrome]
Edits the fluorochrome database.
[Remove Fluorochrome]
Removes the selected fluorochrome from the list.
[Properties]
Displays the properties for the selected spectral reference.
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[Search Results] in the [Library] Window

The following menu commands are displayed when right-clicking a spectral reference in the [Search Results] list.
[Export]
Exports the spectral reference data to a file.
[Delete]
Deletes the selected spectral reference.
[Properties]
Displays the properties for the selected spectral reference.
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Troubleshooting

Check these items before making an inquiry. If the problem still persists after carrying out the recommended actions,
contact your Sony distributor.
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Problem Possible cause Recommended solution

One population
appears
separated.

The Biexponential axis setting is
inappropriate.

If the setting for the negative area of the biexponential axis
is inappropriate, the population will appear jammed up
against the plot axis origin. Check the setting for the
Negative area.

The operation of
Spectral Flow
Analysis is slow.

The number of events displayed is
high.

Reduce the number of events to display to improve
performance.

The number of plots, gates, and
statistics is high.

Turn off fluorescence unmixing, when it is not required, to
improve performance.

There are a large number of plates
in a single experiment.

The operation of the Spectral Flow Analysis software may
become slower as the number of plates created in a single
experiment increases. Reduce the number of plates in an
experiment, for example, by splitting the experiment.

Advanced
analysis does not
complete.

Advanced analysis does not
complete because the load
imposed by the data amount and
learning conditions is heavy.

To terminate advanced analysis even though the data is
not saved, run [Terminate Analysis] of [Analysis] on the
[Analysis] tab and then force terminate the analysis by
clicking [Force Terminate].

Saving an
experiment does
not complete.

Saving an experiment or
terminating analysis will not
complete during execution of an
algorithm.

To force terminate processing despite data saving not
being complete, run [Terminate Analysis] of [Analysis] on
the [Analysis] tab and then click [Force Terminate].
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Software Licenses

This product contains software that Sony uses under a licensing agreement with the owner of its copyright. We are
obligated to announce the contents of the agreement to customers under requirement by the owner of copyright for
the software. Please refer to the "\Others\License" folder in the installation folder for the license information.
Services offered by third parties may be changed, suspended, or terminated without prior notice. Sony does not bear
any responsibility in these sorts of situations.
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